Welcome to Choices 3. This user guide will show you everything you need to know to access and utilize the wealth of information available from Choices 3.

The Choices 3 program is a CD-ROM-based database that is installed on local workstation computers in the McLeod Business Library. These are the only computers with access to this program. Please contact a member of the McLeod Business Library staff for assistance in locating these workstations.

Introduction

The Choices 3 database from Simmons Market Research Bureau allows you to explore a single source measurement of major media, products, services, in-depth consumer demographic characteristics figures and statistics. The CD-ROM contains a wealth of marketing data collected from a comprehensive survey of about 30,000 American adults, which has been projected to reflect the general population. The Simmons National Consumer Study (NCS) is an annual survey of consumer buying habits and preferences, coordinated with demographic characteristics and with media usage and audience. There are about 5,000 questions with 50,000 possible answers. The primary purpose of the study is to assist marketing and advertising researchers in planning and analyzing market strategies. The Choices 3 program makes the effective use of this complex set of information easy and fast.
# Table of Contents

Introduction ......................................................................................................................... 1  
Table of Contents ................................................................................................................ 2  
The Opening Screen (Coding Window) ............................................................................. 3  
Basic Operating Steps (Step-by-Step Procedures)............................................................. 5  
    Crosstab..................................................................................................................... .... 5  
    Trend Analysis ............................................................................................................ 10  
    Interactive Press Reach & Frequency ......................................................................... 12  
    Graphing Results ......................................................................................................... 14  
Description of Coding Window Areas............................................................................... 16  
    Menu Bar .................................................................................................................... 16  
    Coding Speed Bar ....................................................................................................... 24  
    Dictionary Browser ..................................................................................................... 28  
    Table Statistics ......................................................................................................... 35  
    Coding Box ................................................................................................................ 38  
The Editor Window ........................................................................................................... 42  
The Choices 3 Viewer Window .......................................................................................... 46  
    Crosstab View ............................................................................................................. 47  
    Analysis View .............................................................................................................. 50  
    Private Eye Ranking View .......................................................................................... 51  
    Trender View .............................................................................................................. 53  
    Choices 3 Viewer Menu Bar ........................................................................................ 55  
The Choices 3 Media Report Viewer Window ................................................................. 63  
    Using the Choices 3 Media Report Viewer Window—R&F ....................................... 64  
        Media Display Area .................................................................................................. 64  
        Schedule Properties Window ............................................................................... 67  
        Optimizing the Schedule ..................................................................................... 70  
        Results Display Area ............................................................................................. 71  
    Using the Choices 3 Media Report Viewer Window—Rank ....................................... 73  
    Using the Choices 3 Media Report Viewer Window—Duplication Analysis ............. 74  
    Using the Choices 3 Media Report Viewer Window—Vehicle Graphs ..................... 74  
Interpreting Choices Data ................................................................................................. 75  
Count Commands .............................................................................................................. 77  
Volumetrics ....................................................................................................................... 79  
Mean ................................................................................................................................. 81  
Understanding Volumetrics and Means .......................................................................... 84  
Definitions ........................................................................................................................ 85  
    General ...................................................................................................................... 85  
    Logical Operators ..................................................................................................... 87  
    Use of Parenthesis ...................................................................................................... 87  
    Functions ................................................................................................................... 88
The Opening Screen (Coding Window)

Choices 3 is available on selected Business Library workstations. Please ask a Business Library staff member for the location of a computer workstation with Choices 3 installed.

The default opening screen, the Coding Window, is pictured below. This screen consists of six major areas.

1. The Menu Bar has pull-down menus to allow you to perform various commands in Choices 3. The menus are: File, Edit, Search, View, Coding, Tools, Survey, and Help. For more information on the Menu Bar please go to page 16.

2. The Coding Speed Bar consists of buttons that enable you to perform various tasks in Choices 3. Many of these tasks are also included in the drop-down menus from the menu bar but allow you to save time by using these shortcuts. For more information on the Coding Speed Bar please go to page 24.

3. The Dictionary Browser allows you to access the Questions and Answers for the survey you are currently using. There are five tabs at the bottom of this section. They are Questions, Net, Media, Alpha, and Definitions. The Questions tab is the default display when the Coding Window is first opened. For more information on the Dictionary Browser please go to page 28.
4. The *Table Statistics* area displays the definitions you have selected to use in your analysis. This area displays the definitions for the Columns/Targets, Rows/Media, Filters, any definitions that may be in the Scratch area, and those that are available for recycling.

The *Table Statistics* area contains four tabs where you may place data for use in an analysis. Select the tab at the bottom of the area to activate any field (i.e., *Cols/Rows*, *Filter*, *Scratch*, or *Recycle*). Only one tab can be viewed at a time. For more information on the *Table Statistics* area please go to page 35.

5. The *Coding* box allows you to create complex expressions. Complex expressions refer to any data combinations that use more than one type of logic. For more information on the *Coding* box please go to page 38.

6. The Status Line is the bottom line of information in the *Coding* window. The right side of the Status Line indicates the survey being used. The survey may be changed by clicking on the *Change Survey* button in the Tool Bar or selecting *Change Survey* in the *Survey* menu. See page 5 for more information about changing surveys.
Basic Operating Steps

Crosstab

The following steps are to be taken after you have opened Choices 3. These instructions are for a Crosstab, which is the simplest report to create.

1. **Select Survey.**
   - The first step is to select the survey you wish to use in your research. If no survey is displayed in the Dictionary Browser, or you do not want to use the current survey, click on the Change Survey button or the Change Survey selection in the Survey menu. The available surveys are presented in a Change Survey window. Highlight the survey you want to use by clicking on it.
   - Clicking on the “Transfer current specfile to new survey” check box will move the information in the definitions in the Table Statistics area to the new survey.
   - Once you have selected the survey you want to use, click on the OK button and that survey will be loaded into the Choices 3 program.
   - The Status Line in the Coding Window will change to reflect the name of the survey.
   
   **Note:** A survey may have two different “weights,” either POP or HHLD. The POP weight projects all respondents in the survey to the total survey population. HHLD projects respondents to total households in the survey. Some surveys have only one selection (i.e., POP or HHLD) available.

2. **Select the Filter(s).**
   - With a survey displayed in the Dictionary Browser, open the Lifestyle (Demographics) question list by clicking on the “+” or double clicking on the title. This will display the questions contained in this question list.
• As you click on a question, the possible answers are displayed in the *Answer List* box to the right of the list of questions. An example of a selection for a filter would be “Gender.”

• In the *Answer box*, select “Male” or “Female” by highlighting the answer. Note, more than one filter may be selected for a single Crosstab. Once you have selected an answer (“Male” in this analysis), click on the **Change Filter** button above the *Answer* box. This will place the answer into the *Filters* box in the *Table Statistics* area. The number of filters currently in use are displayed in the parentheses after the word “Filters” at the top of the *Table Statistics* area.

**Note:** For instructions on how to create a complex coding expression to narrow the universe of your analysis please go to the *Coding* box section on page 38.

3. **Select the Columns.**

• Once you have selected a filter (if any are desired) you should select the answers you want to use in the columns of your analysis. You may do this by browsing through the dictionary or by using the search function.

**Note:** Complex coding expressions may be built by using the *Coding* box. See page 38 for more information about the *Coding* box.

**Note:** To set up special count commands (page 77) or to determine the consumption of a product or service use volumetric (page 79) or mean (page 81) functions go to the page indicated.

• **Browsing:**

  * To use the browser, open the question list below the title you want to browse by clicking on the “+” or double clicking on the title.

  * As you click on a question, the possible answers are displayed in the *Answer List* box to the right.

  * In the *Answer List* box, select the answer you want to use by highlighting it with your mouse pointer. You may select more than one answer by either holding down the *Control [Ctrl]* key while you click on the answers, or . . .

  * To select a group of answers click on the first one you want, hold down the *Shift* key and click on the last answer in the group that you want. All answers between the first and the last one selected will be highlighted.

  * Once you have selected all the answers you want, click on the **Add to Columns/Targets** button. This will place the answers into the *Columns/Targets* box of the *Table Statistics* area. The number of answers will be indicated in the parentheses after “Columns/Targets.”
In this example we selected the eight age answers for the ages 22 through 59.

**Search:**

- To use the Alpha search function, click on the **binocular** button above the *Question List* box. This opens the *Alpha Search* window. There are two tabs in the *Alpha Search* window. **Alpha** (the one displayed when the window opens) and Advanced (the Advanced selection does not work). For the **Alpha** search, type a term into the **Search string** field. In this example “age” has been entered.

- Click on the **Search** button and the results of the search will be displayed in the *Results* box. You have the option to search in the Answer level or the Question level. Select the option you want by clicking on the radio button next to your selection. Then highlight the term you want and click on the **OK** button.

- The titles in the question list with that term included in the questions (or answers) will be the only titles displayed in the **Alpha** tab in the *Question List* box.

- Open the question list you want and select the answers you want by highlighting them and clicking on the **Add to Columns/Targets** button. Selecting the same age group answers as in the Browse section above will give you the same answers in the *Columns/Targets* box of the *Table Statistics* area.

4. **Select the Rows:**

- Once you have selected a filter (if any are desired) and the columns you should select the answers you want to use in the rows of your analysis. You may do this by browsing through the dictionary or by using the search function.

**Note:** Complex coding expressions may be built by using the **Coding** box. See page 38 for more information about the **Coding** box.

**Note:** To set up special count commands (page 77) or to determine the consumption of a product or service use volumetric (page 79) or mean (page 81) functions go to the page indicated.

**Browsing:**

- To use the browser, open the question list below the title you want to browse by clicking on the “+” or double clicking on the title.

- As you click on a question, the possible answers are displayed in the *Answer List* box to the right.
* In the Answer List box, select the answer you want to use by highlighting it with your mouse pointer. You may select more than one answer by either holding down the Control [Ctrl] key while you click on the answers, or . . .

* To select a group of answers click on the first one you want, hold down the Shift key and click on the last answer in the group that you want. All answers between the first and the last one selected will be highlighted.

* Once you have selected all the answers you want, click on the Add to Rows/Media button. This will place the answers into the Rows/Media box of the Table Statistics area. The number of answers will be indicated in the parentheses after “Rows/Media.”

* In this example we selected seven answers under “Family Restaurants – Visit Most Often.”

<table>
<thead>
<tr>
<th>Rows/Media [?]</th>
<th>Sample</th>
<th>Weighted</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAMILY RESTAURANTS - VISIT ...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FAMILY RESTAURANTS - VISIT ...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FAMILY RESTAURANTS - VISIT ...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FAMILY RESTAURANTS - VISIT ...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FAMILY RESTAURANTS - VISIT ...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FAMILY RESTAURANTS - VISIT ...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FAMILY RESTAURANTS - VISIT ...</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Search:**

* To use the search function, click on the binocular button above the Question List box. This opens the Alpha Search window. Type a term into the Search string field. For example, “Family.”

* Click on the Search button and the results of the search will be displayed in the Results box. Highlight the term you want and click on the OK button. The titles in the question list with that term included in the answers will be the only titles displayed in the Alpha tab in the Question List box.

* Open the question list you want and select the answers you want by highlighting them and clicking on the Add to Rows/Media button. Selecting the same answers as in the Browse section above will give you the same answers in the Rows/Media box of the Table Statistics area.

5. **Perform a Run Analysis (Crosstab).**

* Now that your data elements have been selected it is time to perform a function on that information.

* To run a Crosstab, click on the Run Analysis button on the Coding Speed Bar or select Run Analysis in the Coding menu. A shortcut would be to press the Control [Ctrl] and R keys.

* An animated Processing icon is displayed while the analysis is being run. This may take a few moments depending on the complexity of the analysis.

* The Choices 3 Viewer window is opened when the processing is completed. See page 46 for more information about the Choices 3 Viewer. For help interpreting the data, go to Interpreting Choices Data on page 75.
6. **Saving the Crosstab.** You may save your results by exporting them to your USB Flash Drive by selecting **File** from the Menu Bar, **Export** from the drop-down menu and then **Spreadsheet (CSV) File** from the sub-menu.

When the **Save As** window appears select the target for your file from the drop-down menu in the **Save in:** data field. If you are using a USB Flash Drive, select the D: or E: drive (depending on the computer being used). Then type a name for your file in the **File name:** data field. Finally, click **Save.** The file may then be opened using Microsoft Excel®.

Selecting **Excel** from the **File, Export** sub-menu will open the file in Excel. You may then manipulate the data before you save it.

7. To exit the Choices 3 Viewer window and return to Choices 3, click on the **Return to Choices** button in the tool bar. This will return you to the Choices 3 screen without closing the Choices 3 Viewer window.

To exit the Choices 3 Viewer by closing it, select **Exit** from the **File** menu. If the file has not been saved, you will see a window asking you if you want to save your work. Click **Yes** and the **Save As** window will be displayed. Click **No** and the Choices 3 Viewer window will be closed and you will be returned to the Choices 3 screen.
**Trend Analysis**

A Trend Analysis allows you to analyze multiple years of data in a single report. You may view the results for each survey separately or compare data on year to year changes.

Note: The number of studies available for analysis varies from time to time. If only one study is available, a trend analysis cannot be performed.

1. To perform a Trend Analysis, use the same procedures in the Crosstab to set up the Filter(s), Columns and Rows. See page 5 for information on setting up a Crosstab.

2. Once you have data elements chosen, click on the Run Trend Analysis button or select Run Trend Analysis in the Coding menu.

3. The Trend Analysis Report Format window opens. Using this window you may select which surveys to use.

Highlight the survey(s) you want to include by clicking on the survey in the Available Surveys box. With a survey highlighted, click on the Add button and that survey will be added to the list in the Selected Surveys box.

The surveys are presented in the Trend Analysis in the order in which they are listed in the Selected Surveys box. It is best to view them in chronological order so if the surveys are not listed in order, you may rearrange them by removing them and re-selecting them in the order you want. The selected Surveys box will display any recently used surveys when it is first opened. You may remove any of them you do not wish to use. The red arrow indicates the current survey.

4. When you have selected all the surveys you want to use in your analysis, click on the OK button.

5. An animated Processing icon is displayed while the analysis is being run. This may take a few moments depending on the complexity of the analysis.

6. The Choices 3 Viewer window is opened when the processing is completed. The table of contents on the left side of the screen indicates the various ways the Trend Analysis may be displayed. Information about the Trender View in the Choices 3 Viewer window may be found on page 53.

Under the Crosstab View topic in the table of contents you have the option of viewing the standard Crosstab information according to...
survey. This will display a complete crosstab with all the data elements. You may select the
survey to view by clicking on its subheading below the Crosstab View topic.

You may also view the Trend Analysis results by clicking on the Trender View topic in the
table of contents. Each element is displayed, one at a time, with the data from each survey
displayed. You may move from data element to data element by clicking on
the arrows above the upper right of the display area.

The bottom line of the Choices 3 Viewer window indicates the survey being displayed and
the base (filter, i.e., male or female). The base may be changed by clicking on the Change
Base button on the Choices 3 Viewer tool bar. This will open
the Select Base window. Clicking on the down arrow will
display the selections available. Highlight the selection you
want and click on the OK button. This will change the base
being displayed in the Choices 3 Viewer window.

You may select how the data is displayed by clicking on the Trender
Settings icon on the Choices 3 Viewer tool bar. This will open the
Trender Options window. You may select the comparison type you want by clicking on the
radio button next to your choice. You may also choose
the Comparison Values by clicking on the check box
next to one or both of the values available. Click on the
OK button when you are finished making your choices.
Interactive Press Reach and Frequency

An Interactive Press Reach and Frequency Analysis allows you to build and assess print schedules based on target audience definitions that you choose for the columns in Choices 3. Choices 3 uses the MetherPlus Reach and Frequency model to estimate expected results for a given schedule.

1. To perform an Interactive Press Reach and Frequency Analysis, use the same procedures in the Crosstab to set up the Filter (s) and Columns. See page 5 for information on setting up a Crosstab.

   For the rows, you must use the Media tab in the Dictionary Browser. This will display the available media types and the various media vehicles that are included in each. For example, there are 180 magazines included in the Magazines topic for the Fall 2005 POP survey.

   Click on a Magazine topic and select the various magazines from the list (more than one may be selected by holding down the Control [Ctrl] key while clicking with the mouse). When you have the magazines you want click on the Add to Rows/Media button. This will place the magazines into the Rows/Media box of the Table Statistics area.

2. Once you have data elements chosen, click on the Interactive Press Reach & Frequency button or select Interactive Press Reach & Frequency in the Coding menu.

3. This opens the Choices 3 Media Report Viewer window. Information about the Choices 3 Media Report Viewer window may be found on page 63.

   Note: This window has its own menu and tool bars allowing you to format, sort, print, or export the results.

4. Saving the Interactive Press Reach and Frequency. You may save your results to your floppy disk or Zip disk by selecting Save As from the File menu.
When the Save As window appears select the target for your file from the drop-down menu in the Save in: data field. If you are using a USB Flash Drive, select the D: or E: drive (depending on the computer you are using). Then type a name for your file in the File name: data field. Finally, click Save. The file may then be opened whenever you are using the Choices 3 Media Report Viewer window.

5. To exit the Choices 3 Media Report Viewer window and return to Choices 3, click on the Return to Choices icon in the tool bar. This will return you to the Choices 3 screen without closing the Choices 3 Media Report Viewer window.

To exit the Choices 3 Media Report Viewer by closing it, select Exit from the File menu. If the file has not been saved, you will receive a window asking you if you want to save your work. Click Yes and the Save As window will be displayed. Click No and you will be returned to the Choices 3 screen.
Graphing Your Results

Once Choices 3 has completed its analysis and the results are presented in the Choices 3 Viewer, you have several options for having the results presented in a graph. To graph your results, from the Choices 3 Viewer window select either the Create Graph (Excel) or Create Graph button.

Create Graph (Excel)

To create a graph in Excel you may either click on the Create Graph (Excel) button or select Chart in Excel in the Analysis menu selection. (You also may press the X key while holding the Control key (Ctrl + X).

This opens the MS Excel Chart Parameters window.

1. Select the data type (i.e., index) from the drop-down menu in the Data Type data field.
2. Select the chart type (i.e., column, pie, etc.) from the drop-down menu in the Chart Type data field.
3. Select the data you want displayed on the horizontal axis by selecting elements displayed in the Category (Horizontal) Axis box.
4. Select the data you want displayed on the vertical axis by selecting elements displayed in the Values Vertical Axis box.
5. Click OK to have your chart made.
6. This opens the Excel program.

When the chart is displayed, you may format the chart area, select a new chart from a variety of chart types, add a legend, or perform a number of other actions.

You may save or print the chart using the various selections from the Excel window menu bar. Please remember, if you are saving your chart to a disk that if you are using a USB Flash Drive, select the D: or E: drive (depending on the computer you are using).
Create Graph

To create a graph using the *Choices 3 Viewer* window, you must first select a range of cells by highlighting the cells you want to graph by clicking and dragging with your mouse pointer.

Clicking on the **Create Graph** button will open the *Element* window. This window allows you to select the element (i.e., Weighted, Index. etc.) you wish to have graphed.

Once you have made your selection click on the **OK** button.

This will open the graph in the *Choices 3 Viewer* window display area. The chart is also added to the table of contents column on the left side of the page.

The graph is initially displayed as a horizontal bar chart. The buttons in the upper right corner of the screen allow you to change the display to a vertical bar chart, a pie chart, a line chart, or switch the vertical and horizontal elements.
Description of Coding Window Areas

Menu Bar


File

The File drop-down menu contains commands for New, Open, Save, Save As, and Exit. These commands allow you to save and retrieve data, clear and start a new worksheet, and exit the Choices 3 software program.

New. Allows you to clear out any data that appears in the Table Statistics area. This is the same results you receive when clicking on the New button in the Coding Speed Bar.

Open. Allows you to open any saved files. Clicking on the Open selection, or the Open button on the Coding Speed Bar, will open the Open window. You must then select where your file is located (D: or E: drive for a USB Flash Drive) and which file to open.

Save. Selecting Save, or clicking on the Save button on the Coding Speed Bar, will save any changes you may have made to a previously saved worksheet. The Save selection (and Save button) are grayed out until a document that was previously saved is changed.

Save As. Allows you to save data that is in the worksheet. Selecting Save As will open the Save As window. You must then select where your file is to be located (D: or E: drive for a USB Flash Drive) and what to name it.

Recently used worksheets. Below the Save As selection is a list of previously opened worksheets or studies. If you want to reopen one of these click on the item in the list and it will be opened.

Exit. Allows you to exit the Choices 3 software program.

Edit

The Edit menu selection contains a drop-down menu of a selection of operations you can perform on data elements in the Coding box. These are: Undo, Copy, Cut, Paste, Clear All, and Delete. These selections are grayed out until data is entered into the Coding box. Then actions may be performed on that data using these selections. See page 38 for more information about the Coding Box.
The other selection in the **Edit** menu is **Options**.

Clicking on the **Options** selection opens the **Options** window. This window provides information about the location of various Choices 3 files. This information is already set up for optimum performance of the program and must not be changed.

**Search**

The **Search** menu selection contains a drop-down menu with four search selections. These are **Find Question**, **Find Answer**, **Find Next Question**, and **Find Next Answer**. These selections are used to find questions and answers in the **Dictionary Browser** area of the Choices 3 screen.

Selecting **Find Question** opens the **Alpha Search** window. This is the same window opened when the **binocular** button above the **Dictionary** window is clicked on.

Type a term into the **Search string** field. In this example “age” has been entered.

Click on the **Search** button and the results of the search will be displayed in the **Results** box. Highlight the term you want and click on the **Find in dictionary** button. The titles in the question list with that term included in the answers will be the only titles displayed in the **Alpha** tab in the **Question List** box.

The Advanced tab in the **Alpha Search** window does not work.

The other selections in the **Search** menu are grayed out until an answer is selected (highlighted) in the **Answer List** box.

Selecting **Find Answer** will open the **Find** window. Enter a word into the **Enter word to search for** data field and click on **OK**. The first instance of this word will be highlighted in the **Answer List** box. However, the list in the **Answer List** box does not automatically scroll to that word, you must manually scroll down the list to find the highlighted word.

The **Find Next Question** and **Find Next Answer** selections in the **Search** menu do not perform any function.
To find the next instance of the word you are searching for in the Answer List box, **right click** in the Answer List box to open the Context menu. This menu has two selections for **Find** and **Find Next**.

Selecting **Find** will open the **Find** window.

Clicking on **Find Next** will cause the next instance of the word you first searched for to be highlighted. Again, the list in the Answer List box does not automatically scroll. You may keep selecting **Find Next** until the last instance of the word is found, after that clicking on **Find Next** will display the **Find Next Answer** window with the message that no more occurrences were found.

**View**

Selecting the **View** menu causes a drop-down menu to appear with three selections. These selections are **Table Statistics**, **Coding Box**, and **Coding Speed Bar**.

Clicking on **Table Statistics** causes the display of the Coding Window to include or eliminate the Table Statistics box. This is the same function the **Table Statistics** button in the Coding Speed Bar performs.

Clicking on **Coding Box** causes the display of the Coding Window to include or eliminate the Coding box. This is the same function the **Coding Box** button in the Coding Speed Bar performs.

Clicking on **Coding Speed Bar** causes the display of the Coding Window to include or eliminate the Coding Speed Bar just below the Menu Bar.

**Coding**

When the **Coding** menu is accessed, Choices 3 will display a drop-down menu with a variety of selections. These are **Answer List**, **Coding Box**, **Logic**, **Numeric**, **Comparison**, **Edit Table**, **Run Analysis**, **Interactive Press Reach & Frequency**, and **Run Trender Analysis**.

The **Edit Table** selection opens the Editor window. This is the same function the **Edit Table** button in the Coding Speed Bar performs. See page 42 for more information about the Editor window.

The **Run Analysis** selection performs an analysis on the selected data elements in the rows and columns boxes. This will then open the Choices 3 Viewer. This is the same function the **Run Analysis** button on the Coding Speed Bar performs. Please go to page 5 for more information about running an analysis.

The **Interactive Press Reach & Frequency** selection will run a Reach and Frequency analysis. This will open the Choices 3 Media Report Viewer window. This is the same function the **Interactive Press Reach & Frequency** button on the Coding Speed Bar performs. Please go to page 12 for more information on running an Interactive Press Reach and Frequency.

The **Run Trender Analysis** selection performs a Trend Analysis on the selected data elements in the rows and columns boxes across a number of surveys. This will then open the...
**Choices 3 Viewer** with a Trender View option. This is the same function the **Run Trender Analysis** button on the Coding Speed Bar performs. Please go to page 10 for more information about running a Trend Analysis.

The **Answer List, Coding Box, Logic, Numeric, and Comparison** selections each have another drop-down menu. These menus offer various procedures and functions to manipulate data elements in the **Coding Box** and the **Table Statistics** area. Please see page 38 for more detailed information about the **Coding** box.

The **Answer List** sub-menu items **Add Filters, Add Columns/Targets, Add Rows/Media, and Add Scratch** enable you to add data elements to the **Filter** box, **Columns/Targets** box, **Rows/Media** box, or the **Scratch** box. In order to use these selections you must first have an element in the **Answer List** box highlighted.

The **Add to Coding** selection allows you to add coding statements to the **Coding** box (with the logic connector “OR”, “AND” or “,”).

To use the **Combine** selection you must have an expression (with logic connectors between elements and ending with a logic connector) in the coding box. Highlight an element in the **Answer List** box, select where to move the combined expression (**to Filters, to Columns, to Rows, or to Scratch**) and the highlighted element will be added to the end of the expression in the **Coding** box and it will be moved to the desired box in the **Table Statistics** area.

The **Coding Box** sub-menu items are used to perform functions on coding statements in the **Coding** box.

The **Add Filters, Add Columns/Targets, Add Rows/Media, and Add Scratch** selections will move a coding statement from the **Coding** box to the indicated section of the **Table Statistics** (i.e., Filters, etc.) area.

The **Clear** selection will clear all coding statements from the **Coding** box.

Once you have an expression in the **Coding** box, you may use the **Cell Lookup** selection to determine the Sample size and the Weighted value of the combined expression.

Clicking on the **Cell Lookup** selection opens the **Cell Lookup** window. This is the same window that is opened when the **Cell Lookup** button is clicked on in the **Coding** box tool bar.
This window gives you the full User Heading, System Heading, and Coding expression in addition to the Sample size and the Weighted value.

The **Keyword Lookup** selection allows you to select a specific keyword in an expression (by highlighting it).

Clicking on the **Keyword Lookup** selection will open the **Keyword Lookup** window. This is the same window that is opened when the **Keyword Lookup** button in the **Coding** box tool bar is clicked on.

This window gives you the keyword selected and its full description.

The **Heading Editor** selection allows you to modify the heading for any keyword in the **Coding** box.

To modify a heading, highlight the desired keyword in the **Coding** box and click on the **Heading Editor** selection. This will open the **Heading Editor** window. This is the same window that is opened when the **Heading Editor** button in the **Coding** box tool bar is clicked on.

You may change the heading in the **User Heading** box. If you want to use the System heading click on the **Use System Heading** button. If you want to return the User Heading to its original form, click on the **Reset** button.

When you are finished, click on the **OK** button.

The **Check Expression Syntax** allows you to check the expression that is in the **Coding** box.

To check the syntax select **Check Expression Syntax** in the **Coding Box** sub-menu. This will open the **Expression Error** window if there is an error in the syntax. This is the same window that will open if the **Check Expression Syntax** button in the **Coding** box tool bar is used.

The section of the expression that is highlighted is the location of the syntax error.

If there is no error, you will receive a message that the expression is valid.
Using the Create/Edit Synonyms selection opens the Synonyms window. This window allows you to name the synonym you are creating.

Synonyms are used to define a single definition under a more convenient user defined name or keyword. The Synonym name can then be used to reference the definition within further coding. To create a synonym follow these steps:

- Create the complex definition in the Coding box.
- Enter a description for the definition.
- Open the Synonyms window.
- In the Name data field enter a name for the synonym and click on the Add button.

To use a synonym simply type in the name of the synonym directly into the Coding box.

Synonyms are most useful when you have a complex definition, which you want to use many times in other definitions, without having to keep re-creating it.

The Logic sub-menu items are used to add logical operators between keywords while building an expression in the Coding box.

The operators available are AND, OR, XOR, NOT, “(“ and “)”. See page 85 for definitions and more information about logical operators.

To use these operators, first move a keyword into the Coding box. Then select one of the operators and it will be added to the end of the expression. Add another keyword by moving it into the Coding box.

You may also add an operator by placing the cursor in the Coding box in the desired location in the expression. Then select the operator you want. It will be placed in the position where the cursor was located.

You may also use the AND, OR, XOR, NOT, “(“ or “)” buttons in the Coding box tool bar to accomplish the same tasks as the Logic selections in the Coding Box sub-menu.

The Numeric sub-menu items are used to add numeric operators to the expression you are building. These numeric operators are “/” (divide), “*” (multiply), “-” (subtract), and “+” (add).

To use these operators, first move a keyword into the Coding box. Then select one of the operators and it will be added to the end of the expression. Add another keyword by moving it into the Coding box.

You may also add an operator by placing the cursor in the Coding box in the desired location in the expression. Then select the operator you want. It will be placed in the
position where the cursor was located.

You may also use the “+” button in the Coding box tool bar to accomplish the same tasks as the Numeric selections in the Coding Box sub-menu.

The Comparison sub-menu items are used to add comparison operators to the expression you are building. These comparison operators are “=” (equal), “>=” (greater than or equal to), “<=” (less than or equal to), “>” (greater than), and “<” (less than).

To use these operators, first move a keyword into the Coding box. Then select one of the operators and it will be added to the end of the expression. Add another keyword by moving it into the Coding box.

You may also add an operator by placing the cursor in the Coding box in the desired location in the expression. Then select the operator you want. It will be placed in the position where the cursor was located.

You may also use the “>” button in the Coding box tool bar to accomplish the same tasks as the Comparison selections in the Coding Box sub-menu.

**Tools**

There is only one selection in the drop-down menu for the Tools menu selection. The drop-down menu has the Retrieve Saved Definitions selection.

Clicking on the Retrieve Saved Definitions selection opens the Retrieve Saved Definitions window. To open a definition highlight the definition you want (if any have been saved). Next click on the radio button next to the destination where you want the definition to be placed (i.e., Rows, Columns, etc.). Finally, click on the OK button.

Refer to The Editor Window section on page 42 for information about saving a definition.

**Survey**

Selecting the Survey menu causes a drop-down menu to appear with five selections. These selections are Change Survey, Install Survey, Change Survey Language, Rebuild Headings, and View Survey Information.

Clicking on Change Survey opens the Change Survey window. This is the same window that is opened when the Change Survey button on the Coding Speed Bar is clicked on.

You may use this window to select a different survey to use in your research. To change the survey, highlight the survey you want to use and click on OK. This will
change the survey in Choices 3. The new survey will be listed in the Status Line at the bottom of the Coding window.

The **Install Survey** selection is used to install new surveys for the Choices 3 program.

There is only one language available (English) for these surveys. There is no need to select **Change Survey Language**.

The **Rebuild Headings** selection returns all user headings that you may have modified to the original system headings. See page 45 for more information about modifying headings in the Editor Window.

Clicking on **View Survey Information** opens the Survey Information window. This window displays information about the survey currently loaded in Choices 3.

---

**Help**

The **Help** menu has two selections, **Register** and **About**. The **About** selection will give you information about the Choices 3 program.

The Register selection is used to register the program with the vendor. The program is already registered.

The Help button on the toolbar will open a general help window for you.
Coding Speed Bar

The Coding Speed Bar contains buttons for performing a number of functions in the program.

The buttons are New, Open, Save, Cut, Copy, Paste, Undo, Change Survey, Switch to Default Survey, View Survey Information, Run Analysis, Run Trender Analysis, Interactive Press Reach & Frequency, Edit Table, Table Statistics, Coding Box, and Contents.

Clicking on the New button will remove all data in the Table Statistics area and the Coding box.

If the data had not been saved you will receive a Help window with a message that will prompt you to save the material. If you do not want to save the data, click on No and the data will be cleared from those boxes. Note that the Answer List box will not be cleared.

Clicking on Yes will open the Save As window so you can name the file and select its destination.

This is the same function performed by selecting New in the File menu.

Clicking on the Open button will open the Open window. If there are any previously saved files you may select one by highlighting the file name and open it by clicking on the OK button in the Open window.

This is the same function performed by selecting Open in the File menu.

The Save button will open the Save As window. This window prompts you to name the file and select where the file will be saved to. The USB Flash Drive is the D: or E: drive (depending on the computer being used).

You may save the file to the default Choices 3 directory or to your disk.

This is the same function performed by selecting Save or Save As in the File menu.
The **Cut**, **Copy**, **Paste** and **Undo** buttons work with data in the **Coding** box. They are grayed out until data has been entered into the **Coding** box. These are the same functions performed by selecting **Cut**, **Copy**, **Paste**, or **Undo** in the **Edit** menu.

You may cut a data element out of an expression in the **Coding** box by highlighting it and then clicking on the **Cut** button. The highlighted item will disappear from the **Coding** box, it will be available to be put back in using the **Paste** button until other data has been cut or copied.

The **Copy** button allows you to copy a highlighted data element in the **Coding** box. The highlighted element will not be removed but will be copied to the program’s clipboard. This way you may have the same element in the expression twice.

Clicking on the **Paste** button will insert the data that is on the program’s clipboard into the expression in the **Coding** box at the location where the cursor is positioned.

The **Undo** button allows you to back up (recover) from a cut or paste operation that you may wish to correct or modify. The **Undo** button will only undo one (the last) action.

Clicking on the **Change Survey** button opens the **Change Survey** window. This is the same window that is opened when **Change Survey** in the **Survey** menu is selected.

You may use this window to select a different survey to use in your research. To change the survey, highlight the survey you want to use and click on **OK**. This will change the survey in Choices 3. The new survey will be listed in the Status Line at the bottom of the **Coding** window.

Clicking on the **Switch to Default Survey** button will return the program to the original survey that is displayed when the program first opens.

Clicking on the **View Survey Information** button opens the **Survey Information** window. This window displays information about the survey currently loaded in Choices 3. This is the same window that is opened when **View Survey Information** is selected in the **Survey** menu.
The **Run Analysis** button allows you to run an analysis (i.e., Crosstab) on the elements you entered into the **Filters, Columns/Targets**, and **Rows/Media** boxes in the **Table Statistics** area. This will open the **Choices 3 Viewer** window. Please go to page 5 for information on setting up Choices 3 for an analysis. Please go to page 46 for more information about the **Choices 3 Viewer** window.

This is the same operation that will be performed by selecting **Run Analysis** in the **Coding** menu.

The **Run Trender Analysis** button allows you to run an analysis on the elements you entered into the **Filters, Columns/Targets**, and **Rows/Media** boxes in the **Table Statistics** area. This analysis will be run across a number of surveys.

The **Trend Analysis Report Format** window is opened so that you may select the surveys for your Trend Analysis.

The **Choices 3 Viewer** window is opened with the results of your analysis. Please go to page 10 for information on setting up Choices 3 for a Trend analysis. Please go to page 46 for more information about the **Choices 3 Viewer** window.

This is the same operation that will be performed by selecting **Run Trender Analysis** in the **Coding** menu.

The **Interactive Press Reach & Frequency** button allows you to run an analysis on the elements you entered into the **Filters, Columns/Targets**, and **Rows/Media** (**Rows/Media** should be selected from the **Media** tab in the Dictionary Browser) boxes in the **Table Statistics** area.

The **Choices 3 Media Report Viewer** window is opened with the results of your analysis. Please go to page 12 for information on setting up Choices 3 for a Interactive Press Reach and Frequency analysis. Please go to page 63 for more information about the **Choices 3 Media Report Viewer** window.

This is the same operation that will be performed by selecting **Interactive Press Reach & Frequency** in the **Coding** menu.

Clicking on the **Edit Table** button will open the **Editor** window. This window allows you to modify the user headings for the expressions in the various boxes in the **Table Statistics** area (i.e., Filters, Columns/Targets, etc.). This is the same window that is opened when you select **Edit Table** in the **Coding** menu. Please go to page 42 for more information about the **Editor** window.
Clicking on the **Table Statistics** or the **Coding Box** buttons allows you to view the *Coding* window with or without the *Table Statistics* area or the *Coding* box. These buttons toggle the display of these items on and off.

Above left. The *Coding* window with both the *Table Statistics* area and *Coding* box displayed. Above right. The *Coding* window with the *Table Statistics* area toggled off. The *Dictionary Browser* is displayed across the entire screen and the *Coding* box is on the bottom.

Above left. The *Coding* window with both the *Table Statistics* area and *Coding* box toggled off. Above right. The *Coding* window with the *Coding* box toggled off. The *Dictionary Browser* and *Table Statistics* areas fill the entire screen vertically.

The **Contents** button opens the *Choices 3 Help* window. You may use this window to search for and access help information about the *Choices 3* program.
Dictionary Browser

The Dictionary Browser gives you access to the questions and answers from the survey. The Dictionary Browser area consists of two boxes, the Question List box on the left and the Answer List box on the right. Each box has a set of buttons above it to perform functions for that box.

There are a set of tabs across the bottom of the Dictionary Browser area. The tabs are Questions, Net, Media, Alpha, and Definitions. These are described later in this section. The default tab is the Questions tab.

For simple step by step instructions for setting up an analysis such as a Crosstab go to page 5. The following pages include detailed descriptions of the various functions and procedures available in the Dictionary Browser.

Question List Box

The Question List box has the questions included in the survey in an expandable table of contents arrangement. Clicking on a topic or on the “+” beside the topic opens the topic to reveal the questions.

Clicking on a question displays that question’s associated answers in the Answer List box.
Question list buttons

There is a set of six buttons above the questions list box. These buttons are Binocular (search), Include Subject Heading, Include Question Heading, Answer Heading First, Media Diary, and Filter By Region. These buttons are described below.

Binocular (Search)

You may browse through the questions to find one that suits your research or you may use the Binocular button to perform a search.

To use the Alpha search function, click on the Binocular button above the Question List box. This opens the Alpha Search window. Type a term into the Search string field. In this example “age” has been entered.

Click on the Search button and the results of the search will be displayed in the Results box. Highlight the term you want and click on the Find in dictionary button. The titles in the question list with that term included in the answers will be the only titles displayed in the Alpha tab in the Question List box.

You may then click on the question you want and the answers will be displayed in the Answer List box. Select the answers you want by highlighting them. Move them to the desired section of the Table Statistics area by clicking on the appropriate button above the Answer List box.

The Advanced tab in the Alpha Search window does not work.

The Include Subject Heading, Include Question Heading, and Answer Heading First buttons affect the manner in which the answers are displayed in the various boxes in Choices 3.

Include Subject Heading and Include Question Heading

Note: These buttons are used in conjunction with each other. Whenever the Include Subject Heading button is selected, the Include Question Heading will automatically be selected as well. If both have been selected and the Include Question Heading is de-selected the Include Subject Heading button is also de-selected. However, if both are de-selected the Include Question Heading may be selected without selecting Include Subject Heading.

The Include Question Heading button causes the question heading as well as the answer to be displayed in the various boxes (i.e., Columns/Targets, Filters, Choices 3 Viewer, etc.). This is displayed as Demographics (Personal Information) Gender: Female or Demographics (Personal Information) Age: 20-22, for example. If the Include Question Heading button is de-selected only the answer is displayed (i.e., Female or 20-22).

Answer Heading First

The Answer Heading First button’s default condition is to be de-selected. That is, the subject
heading (i.e., Demographics (Personal Information) Age: 20-22, Demographics (Personal Information) Gender: Female, etc.) are first in all boxes (i.e., Columns/Target, Rows/Media, *Choices 3 Viewer*, etc.). If this option is selected the answer will be first with the subject heading last (i.e., 20-22: Demographics (Personal Information) Age or Female: (Demographics (Personal Information) Gender).

**Media Diary and Filter By Region**

The Media Diary and Filter By Region buttons do not perform any functions.

**Question List Context Menu**

The *Question List* box also has a **Context menu** that is accessible by right-clicking with the mouse while the mouse pointer is in the *Question List* box.

The selections on the **Context menu** are **Add to Net Questions, Find, Find Next, and Refresh**.

Clicking on the **Add to Net Questions** selection with a question highlighted will add that question to the **Net tab**. See page 33 for more information about setting up Net questions.

Selecting **Find** will open the **Alpha Search** window, which is the same window opened by clicking on the **Binocular** button.

The **Find Next** selection does not perform any function in the *Question List* box.

Selecting **Refresh** will cause the Question List to be returned to its fully contracted display. That is only the major question headings are displayed. Any answers that had been displayed in the Answer List box will be removed.

**Answer List Box**

The *Answer List* box displays all the answers included in whichever question is selected in the *Question List* box. The *Answer List* box is used to select answers to be included in your analysis.

Answers are selected by highlighting the answer. More than one may be selected at a time by holding down the **Control [Ctrl]** key while clicking on the answers. A series of answers may be selected by clicking on the first answer desired and then clicking on the last answer in the desired series while holding down the **Shift** key.

Once you have selected the answers you want to use in your analysis you must move them to the appropriate box to configure your table (i.e., columns or rows). You do this by clicking on the buttons above the *Answer List* box.

The first four buttons move the highlighted answers to the box in the **Table Statistics** area that the button controls. These buttons are **Change Filter, Add to Columns/Targets, Add to Rows/Media, and Add to Scratch**.

The last button, **Insert Into Coding**, puts the answers into the **Coding** box.
The *Answer List* box is divided into three columns, Answer, Sample and Weighted. The first column, Answer, is where the answers are displayed. The Sample and Weighted columns are empty until you elect to have data displayed.

You may display the Sample and Weighted information for each answer by selecting **Sample and Weighted** from the Context (right click) menu. Sample indicates the number of people in the survey who answered that particular question. Weighted indicates how many people in the general population this data can be projected to include. Three zeros usually have to be added to the end of the number to get the correct figure (i.e., 1,945 is really 1,945,000).

**Answer List Context Menu**

The *Answer List* box also has a **Context** menu that is accessible by right-clicking with the mouse while the mouse pointer is in the *Answer List* box.

The selections on the **Context** menu are **Select All**, **Invert Selection**, **Find**, **Find Next**, **Add Filters**, **Add Columns/Targets**, **Add Rows/Media**, **Add Scratch**, **Add to Coding**, **Combine**, **Define Count Coding**, **Define Mean/Volumetric**, and **Sample and Weighted**.

Clicking on **Select All** will cause all answers in the *Answers List* box to be highlighted. They may then be moved to a box in the *Table Statistics* area as a group.

Selecting **Invert Selection**, with several answers highlighted, will reverse the highlighting so that those that were selected will be de-selected and those that were not selected originally will be highlighted.

Selecting **Find** will open the *Find* window. Enter a word into the **Enter word to search for** data field and click on **OK**. The first instance of this word will be highlighted in the *Answer List* box. However, the list in the *Answer List* box does not automatically scroll to that word, you must manually scroll down the list to find the highlighted word.

Clicking on **Find Next** will cause the next instance of the word you first searched for to be highlighted. Again, the list in the *Answer List* box does not automatically scroll. You may keep selecting **Find Next** until the last instance of the word is found, after that clicking on **Find Next** will display the *Find Next Answer* window with the message that no more occurrences were found.

To move an answer to one of the boxes in the *Table Statistics* area, highlight the answer (or more than one) and select either **Add Filters**, **Add Columns/Targets**, **Add Rows/Media**, or **Add Scratch**. This will add the highlighted answer(s) to the box selected.

To move an answer to the *Coding* box, highlight the answer (or more than one) and select **Add to Coding**. This will add the highlighted answer(s) to the *Coding* box. If more than one answer was highlighted you are given the option of selecting the logical operator (OR, AND, “;”) to use between the expressions.

To use the **Combine** selection you must have an expression (with logic connectors...
between elements and an ending logic connector) in the Coding box. Highlight an element in the Answer List box, select where to move the combined expression (to Filters, to Columns, to Rows, or to Scratch) and the highlighted element will be added to the end of the expression in the Coding box and moved to the desired box in the Table Statistics area.

The Define Count Coding selection opens the Count Coding window. This window allows you to count the number of respondents who fall into at least several categories from a defined list. Please go to page 77 for more information about count commands.

The Define Mean/Volumetric selection opens the Volumetrics/Mean window. This window allows you to set up Volumetrics or Mean Score definitions to use in the various boxes in the Table Statistics area. Please go to page 79 for more information about Volumetrics and page 81 for more information about Mean Score.

Selecting Sample and Weighted displays the Sample and Weighted information in the Sample and Weighted columns for each answer in the Answer List box.

Sample indicates the number of people in the survey who answered that particular question.

Weighted indicates how many people in the general population this data can be projected to include. Three zeros usually have to be added to the end of the number to get the correct figure (i.e., 1,945 is really 1,945,000).

**Dictionary Browser Tabs**

There are five tabs across the bottom of the Dictionary Browser area. These tabs are Questions, Net, Media, Alpha, and Definitions.

The default tab that is displayed when Choices 3 is first opened is the Questions tab. This tab displays all the questions that were included in the survey. This list changes to reflect the questions for the specific survey being used for your research.
Net Tab. The Net tab is used to set up combined answers from two or more answer lists. Using this tab you may join together answers from questions that have identical answer lists. Use the following steps to set up combined answers:

Note that the answer lists must be identical for this function to operate.

1. Select a question from the question list, or find one using the binocular (search) function.
2. Highlight the question and right-click on it to open the Context menu. Select Add to Net Questions.
3. Select a second question with an identical answer list.
4. Highlight this question and again right-click on it to open the Context menu. Select Add to Net Questions.
5. Click on the Net tab to open the list of questions you have put into Net Questions.
6. Select one of the questions, highlight it and right-click on it with the mouse to open the Context menu. Select OR to put the answers into the Table Statistics area joined with the logic operator OR. Select Columns/Targets or Rows/Media from the sub-menu that is displayed.
7. This opens the Net Questions window that prompts you to name the Combined Question Description.
8. Click OK and the combined answer list will be placed in the selected Table Statistics area box (i.e., Rows/Media).
9. All the combined answers will be placed in the Table Statistics area box you selected. If you do not want to use all of the answers you may remove the ones you do not want to use by moving them to the Scratch box or deleting them to the Recycle box.
10. Click on the Questions tab and select a question/answer for the other axis of the table (i.e., columns if you selected rows for your combined answers).
11. Click on the Run Analysis button. This will open the Choices 3 Viewer window.
12. The Crosstab will show the results of this analysis. This analysis is useful in determining the total number of users for a product or service, not just those who use it as their first choice.
**Media Tab.** The **Media** tab contains a question list of all the media type questions in the survey. This tab should be used if you are going to run an Interactive Press Reach and Frequency. The answers available with these questions are usually individual print media vehicles. Please go to page 12 for information on how to set up and run an Interactive Press Reach and Frequency.

**Alpha Tab.** The **Alpha** tab is automatically opened whenever you perform word search using the **Binocular** (search) button. This tab will only display the most recent search. If another search is made the results of that search will replace any previous results.

**Definitions Tab.** The **Definitions** tab will display any saved definitions. Refer to The **Editor Window** section on page 42 for information about saving a definition.
Table Statistics

The *Table Statistics* area displays the current information you have selected for the Filters, Columns/Targets, Rows/Media or Scratch. The items in the *Filters*, *Columns/Targets* and *Rows/Media* boxes will be used when you run an analysis.

The title of each box (i.e., Columns/Targets) is followed by a number in parentheses. This number tells you how many data elements have been placed in that particular box.

You may select the box to be displayed by clicking on the four tabs that are near the bottom of the *Table Statistics* area. These tabs are **Cols/Rows**, **Filter**, **Scratch**, and **Recycle**. The **Cols/Rows** tab is the default tab displayed when Choices 3 is first opened.

The items in the **Filters** box (which is opened by clicking on the **Filter** tab) are used to define the universe of the analysis. Filters are also called Bases in some screens. If no filter is selected the program will use the default universe of all adults, 18+, in the continental U.S. If you select Male or Female, for instance, then the universe will include only the male or female population, 18+, in the continental U.S. You may select more than one filter.

The **Scratch** box (which is opened by clicking on the **Scratch** tab) is used to store data elements that you might want to use in another analysis but did not want to delete. These items will be saved if you save the current specifications (in a Spec file using the **Save** or **Save As** selections in the **File** menu).

This box can also be used as a storage area for building up more complex definitions. This may be used for creating count commands across complex definitions. See page 77 for more information about Count Commands.
The Recycle bin (which is opened by clicking on the Recycle tab) contains any items you have deleted from the other Table Statistics area boxes. This way you may recover a data element that you had used and decided to use for another analysis. This box is purged each time the Choices 3 program is closed.

**Table Statistics Area Context Menu**

The various boxes in the Table Statistics area have Context menus that are accessible by right-clicking with the mouse while the mouse pointer is in the box. The various menus have similar selections.

The selections on the Context menus are Define Count Coding, Define Mean/Volumetric, Move To, Copy To, Delete, Select All, Invert Selection, and Sample and Weighted. The Move To and Copy To selections both have a drop-down menu that allow you to select where to move or copy the selected elements to (i.e., Coding Box, Filters, Rows, [the Rows/Media box has the selection for Columns] or Scratch).

The Define Count Coding selection opens the Count Coding window. This window allows you to count the number of respondents who fall into at least several categories from a defined list. Please go to page 77 for more information about count commands.

The Define Mean/Volumetric selection opens the Volumetrics/Mean window. This window allows you to set up Volumetrics or Mean Score definitions to use in the various boxes in the Table Statistics area. Please go to page 79 for more information about Volumetrics and page 81 for more information about Mean Score.

Clicking on Move To or Copy To allow you to move or copy the highlighted elements to the box of your choice, by selecting the “To” location from the drop-down menu.

Delete will move any highlighted elements to the Recycle box.
Clicking on **Select All** will cause all elements in the box to be highlighted. They may then be moved, copied or deleted as a group.

Selecting **Invert Selection**, with several answers highlighted, will reverse the highlighting so that those that were selected will be de-selected and those that were not selected originally will be highlighted.

Selecting **Sample and Weighted** displays the Sample and Weighted information in the Sample and Weighted columns for each element in the box where you right-clicked to bring up the **Context** menu.

Sample indicates the number of people in the survey who answered that particular question.

Weighted indicates how many people in the general population this data can be projected to include. Three zeros usually have to be added to the end of the number to get the correct figure (i.e., 1,945 is really 1,945,000).

The **Recycle** box **Context** menu has two selections.

To use the **Restore To** selection, first highlight one or more elements in the **Recycle** box then right-click with the mouse, click on the **Restore To** selection and pick the location (**Filters**, **Columns**, **Rows**, or **Scratch**) from the drop-down menu where you want to restore the elements to.

The **Empty** selection allows you to remove all elements from the **Recycle** box, whether they are highlighted or not.
**Coding Box**

The *Coding* box is where you create a complex expression by combining answers using logic operators, numeric operators and comparison operators.

The *Coding* box consists of three data fields, Description, Factor, and the Work Area data field. The Work Area data field is the data field where you may build complex coding statements. The Description data field is used to name the expression you construct. The Factor data field is used to apply a factor to the complex expression. A factor of 100% is the default factor automatically applied.

**Using the Coding Box**

To build a complex expression follow the steps below. In this example we will build an expression (or coding statement) that will include all males and females in the 25 to 44 age group. This expression could then be used as the Filter (or Base) to limit the universe of your analysis to all adults in these ages.

1. Open the Lifestyle/Demographics topics of the question list in the *Question List* box.
2. Select the Gender question so that the Male and Female answers appear in the *Answer List* box.
3. Right-click on Male and select **Add to Coding** from the *Context* menu. This will put the keyword MALE in the Coding box.
4. Right-click on Female in the *Answer List* box and select **Add to Coding** from the *Context* menu. This will put the keyword FEMALE in the Coding box.
5. In the *Question List* box, select Age from the question list so that the list of ages appears in the *Answer List* box.
6. In the *Answer List* box scroll down so that the 25-34 age group is visible. Right-click on it and select **Add to Coding** from the *Context* menu. This will put the keyword AGE2534 in the Coding box.
7. In the *Answer List* box right-click on the 35-44 age group and select **Add to Coding** from the *Context* menu. This will put the keyword AGE3544 in the Coding box.
8. You should now have the keywords MALE, FEMALE, AGE2534 and AGE3544 in the Work Area of the Coding box.
9. In the Work Area, place the cursor before the keyword MALE. Click on the “(” button to place an open parenthesis in front of the keyword.
10. Move the cursor to the space between the keywords MALE and FEMALE. Click on the **Or** button. This will place the logic operator OR between the two keywords.
11. Move the cursor to the end of the keyword FEMALE. Click on the “)” button to place a close parenthesis after the word FEMALE. This now completes the statement (MALE OR FEMALE).
12. Place the cursor in front of the keyword AGE2534. Click on the “(” button to place an open parenthesis in front of the keyword.

13. Move the cursor to the space between the keywords AGE2534 and AGE3544. Click on the Or button to place the logic operator OR between the keywords.

14. Move the cursor to the end of the keyword AGE3544. Click on the “)” button to place a close parenthesis behind the keyword. This now completes the statement (AGE2534 OR AGE3544).

15. Again move the cursor to the space between the two statements (between the “)” and “(” parentheses). Click on the And button to place the logic operator AND between the two statements.

16. This now completes the complex expression (MALE OR FEMALE) AND (AGE2534 OR AGE3544)

17. You should type a name for the expression in the Description data field. “Age Expression” is used in this example.

18. A factor need not be typed into the Factor data field as the default value is 100%.

19. The expression in the Work Area of the Coding box should look like the one pictured.

20. Click on the ADD to Filters button to move the expression into the Filters box in the Table Statistics area.

**Coding Box Tool Bar**

The Work Area data field is the larger data field where complex codes can be created. There is a row of eighteen buttons below the data field. They are: And, Or, Xor, Not, “(”, “)”, “+”, “>”, Clear Coding, Cell Lookup, Check Expression Syntax, Keyword Lookup, Heading Editor, Add to Filters, Add to Columns/Targets, Add to Rows/Media, Add to Scratch, and Replace.

The And, Or, Xor, and Not buttons represent Boolean logic operators (for definitions of these operators see page 87). You may either type these operators into the coding statement or click the appropriate button to have it inserted where the cursor is positioned in the Work Area data field. These commands are also available in the Logic selection in the Coding menu.

The ( and ) (parentheses) buttons allow you to insert parentheses into your coding statement. The use of parenthesis is described on page 87. You may either type these symbols into the coding statement or click the appropriate button to have it inserted where the cursor is positioned in the Work Area data field. These commands are also available in the Logic selection in the Coding menu.
The “+” button allows you to insert numeric operators into the expression you are building. The numeric operators available are “+” (add), “*” (multiply), “-” (subtract), and “/” (divide). You may either type these symbols into the coding statement or click the appropriate button to have it inserted where the cursor is positioned in the Work Area data field. These commands are also available in the Numeric selection in the Coding menu.

The “>” button allows you to insert comparison operators into the expression you are building. The comparison operators available are “>” (greater than), “<” (less than), “=” (equal to), “<=” (less than or equal to), and “>=” (greater than or equal to). You may either type these symbols into the coding statement or click the appropriate button to have it inserted where the cursor is positioned in the Work Area data field. These commands are also available in the Comparison selection in the Coding menu.

Clicking the Clear Coding button will remove all data from the Coding box, including the Description and Factor data fields.

Once you have an expression in the Coding box, you may use the Cell Lookup button to determine the Sample size and the Weighted value of the combined expression.

Clicking on the Cell Lookup button opens the Cell Lookup window. This is the same window that is opened when the Cell Lookup selection is clicked on in the Coding menu.

This window gives you the full User Heading, System Heading, and Coding expression in addition to the Sample size and the Weighted value.

The Check Expression Syntax button allows you to check the expression that is in the Coding box.

To check the syntax click on the Check Expression Syntax button. This will open the Expression Error window if there is an error in the syntax. This is the same window that will open if the Check Expression Syntax selection in the Coding menu is selected.

The section of the expression that is highlighted is the location of the syntax error.

If there is no error, you will receive a message that the expression is valid.

The Keyword Lookup button allows you to look up a specific keyword in an expression (by highlighting it).

Clicking on the Keyword Lookup button will open the Keyword Lookup window. This is the same
window that is opened when the **Keyword Lookup** selection in the **Coding** menu is selected.

This window gives you the keyword selected and its full description.

The **Heading Editor** button allows you to modify the heading for any keyword in the **Coding** box.

To modify a heading, highlight the desired keyword in the **Coding** box and click on the **Heading Editor** button. This will open the **Heading Editor** window. This is the same window that is opened when the **Heading Editor** selection in the **Coding** menu is selected.

You may change the heading in the **User Heading** box. If you want to use the System heading click on the **Use System Heading** button. If you want to return the User Heading to its original form, click on the **Reset** button.

When you are finished, click on the **OK** button.

Clicking on **Add to Filters**, **Add to Columns/Targets**, **Add to Rows/Media**, or **Add to Scratch** will move the entire expression in the **Coding** box to the designated box in the **Table Statistics** area.

The **Replace** button allows you to replace a coding statement in the **Table Statistics** area.

To use this function you must have an expression in the **Coding** box. Highlight the statement to be replaced in the **Table Statistics** (i.e., **Filters** box, **Rows/Media** box, etc.) area. This will cause the **Replace** button, which had been grayed out, to become active.

Then click on the **Replace** button. This will move the expression in the **Coding** box to the **Table Statistics** area and replace the highlighted statement with the one from the **Coding** box.

**Factor Data Field**

The Factor data field is used to apply a factor to a complex expression if a factor other than 100% is needed. A factor other than 100 would be needed if a question was not asked during the entire fieldwork period of the survey and you wanted the question to perform as if it had been asked during the entire period. In this case it would be necessary to apply a factor.

Factoring up a definition involves changing the weighted number that will be displayed either by factoring up (e.g. to double the numbers) or by factoring down (e.g. to halve the numbers). It is much more common to want to factor definitions up rather than down.

The Factor value is a percentage so a Factor of 100% will not alter numbers while a factor of 200 will double the numbers and a factor of 50 will halve the numbers.

Factors may not be applied to expressions used as filters in the **Filters** box of the **Table Statistics** area.
The Editor Window

The Editor window allows you to modify the items in the various Table Statistics area boxes (i.e., Filters, Rows/Media, etc.) as well as various editing functions as described below.

You may access the Editor window from the Coding window by clicking on the Edit Table button in the Coding Speed Bar or the Edit Table selection in the Coding menu.

You may return to the Coding window by clicking on the Return to Coding Window button on the Editor Speed bar or select Return to Coding Window in the File menu.

This will open the Editor window. The Editor window consists of four major areas.

1. The Menu bar has pull-down menus to allow you to perform various commands in the Editor window. The menus are File, Edit, View, and Help.

2. The Editor Speed Bar consists of buttons that enable you to perform various tasks in the Editor window. Many of these tasks are also included in the drop-down menus from the Menu Bar but allow you to save time by using these shortcuts. The Editor Speed Bar may be toggled on or off by selecting Editor Speed Bar in the View menu.

3. The major portion of the Editor window consists of the four editing boxes and a title data field.
4. The Status Line is the bottom line of information in the Editor window. The right side of the Status Line indicates the survey being used.

**Editor Window Editing Boxes and Title Data Field**

The **Title** data field, which is near the top of the Editor window (just below the Editor Speed Bar), is used to assign a name for the analysis you are developing. This title will appear at the top of each page of the report.

There are four editing boxes: **Columns/Targets** (upper left), **Rows/Media** (upper right), **Scratch** (lower left), and **Filters** (lower right). The title of each box is displayed above the box.

Each box has the data elements listed that were placed into the corresponding boxes in the Table Statistics area of the Coding window. The number of data elements in each box is displayed in a set of parentheses following the name of the box.

The editing boxes, in conjunction with the commands in the Menu bar and Editor Speed Bar, allow you to delete, copy, or modify the data elements in the boxes or their attributes (i.e., heading).

**Cut, Copy, Paste, Undo, and Delete Selected Functions**

- You may cut a data element out of an editing box by highlighting it and then clicking on the **Cut** button. The highlighted item will be removed and placed in the program’s clipboard. It will be available to be put back into the Editor window by using the **Paste** button, until other data has been cut or copied.

- The **Copy** button allows you to copy a highlighted data element in an editing box. The highlighted element will not be removed but will be copied to the program’s clipboard.

- Clicking on the **Paste** button will insert the data that is on the program’s clipboard into the editing box at the location where the cursor is positioned.

- The **Undo** button allows you to back up (recover) from a cut or paste operation that you may wish to correct or modify. The **Undo** button will only undo one (the last) action.

- The **Delete Selected** button will remove the highlighted data element(s) from the editing boxes. This material will not be available for reinsertion with the **Paste** button.

The **Cut, Copy, Paste, Undo and Delete Selected** functions are also available in the **Edit** menu.
Search and Replace

The Search and Replace function is accessed by clicking on the **Search and Replace** button or by selecting **Search and Replace** in the **Edit** menu. Clicking on the **Search and Replace** button opens the **Search and Replace** window.

This window allows you to search all or one selected editing box for a particular term (i.e., most, family, etc.) and replace it with another term. This is particularly helpful if you want to change the name of all the data elements in a box or several boxes that might have similar names.

Enter the term you are searching for in the **Search for** data field and the term you want to replace it with in the **Replace with** data field.

Select which box or boxes you want to search by clicking on the radio buttons in the **Range** box. The **Scope** and **Options** boxes give you additional selections for your search.

Click on the **OK** button when you are ready to conduct your search and replace operation.

Clearing an Editing Box

The **Filters**, **Columns**, **Rows**, and **Scratch** buttons allow you to clear all entries from the selected box (i.e., Filters, etc.).

All data elements will be removed from a box by clicking on the specific button. The items do not have to be highlighted. The removed items are not placed on the program’s clipboard.

This function is also available by selecting **Delete all** in the **Edit** menu.

Entering a Factor

A factor for a data element may be adjusted by selecting **Apply Factor** in the **Edit** menu. This selection opens the **Apply a factor to the definition** window.

Using this window you may select a specific time that the answer was in the survey (this will enter a predetermined factor in the **Factor (%)** data field). For example if you decide that you want a factor of 400, you would click on the radio button for 1 out of 4 quarters.

You also have the option of entering your own factor in the **Factor (%)** data field by first clicking on the Enter factor value radio button.

A factor other than 100 would be needed if a question was not asked during the entire fieldwork period of the survey and you wanted the question to perform as if it had been asked during the entire period. In this case it would be necessary to apply a factor.

Factoring up a definition involves changing the weighted number that will be displayed either by factoring up (e.g. to double the numbers) or by factoring down (e.g. to halve the numbers). It is much more common to want to factor definitions up rather than down.

The Factor value is a percentage so a Factor of 100% will not alter numbers while a factor of 200 will double the numbers and a factor of 50 will halve the numbers.
**Heading Editor**

The headings of the data elements in the editing boxes may be modified by double clicking on the data element. This will open the *Heading Editor* window.

You may then modify the heading of the data element by entering your heading into the **User Heading** data field. This heading will then be displayed wherever this element is used, including the *Coding* window, *Choices 3 Viewer* window or *Choices 3 Media Report Viewer* window.

The original heading may be restored by clicking on the **Reset** button.

When you have finished making your changes, click on the **OK** button to close the window.

**Saving and Retrieving Definitions**

You may save a particular definition (data element you have modified) by highlighting it and selecting **Save Selected Definitions** in the *File* menu.

This will open the *Save Selected Definitions* window. Enter a name of the file in the **Filename** data field and a description in the **Description** data field.

Click on the **OK** button when you have finished.

To open a previously saved definition, select **Retrieve Saved Definitions** in the *File* menu.

This will open the *Retrieve Saved Definitions* window. Select the definition by highlighting it. Select the destination for the definition by clicking on the appropriate radio button in the **Add to** box.

Click on the **OK** button when you are ready to retrieve the definition.

**Help**

The **Contents** button, or the **Contents** selection in the *Help* menu will open the *Choices 3 Help* window. You may use this window to search for and access help information about the Choices 3 program.
The Choices 3 Viewer Window

Whenever Run Analysis or Run Trendender Analysis are selected in Choices 3 the results are displayed in a Choices 3 Viewer window. The display and some tool bar buttons may vary from one type of analysis (i.e., Crosstab, Trend, etc.) to another but the general layout and functions are the same throughout.

The Choices 3 Viewer window consists of six major areas.

1. Title bar. The title bar lists the name (if any) of the file being displayed.


3. Tool bar. The tool bar consists of a row of buttons that allow you to perform various functions on the analysis being displayed. The buttons available change depending on the type of analysis. Most of the buttons are grayed out until an analysis is opened.

4. Report Navigator. The table of contents is displayed in the Report Navigator window on the left side of the Choices 3 Viewer window. If more analyses are run without closing the Choices 3 Viewer the new analyses will be added to the table of contents in the Report Navigator.

5. Display area. The display area on the right side of the Choices 3 Viewer window is where the analysis is presented in a table with columns and rows. The Crosstab analysis is the default display when the window is first opened. The form of the table changes depending...
on which analysis is being displayed. For help interpreting the data, go to Interpreting Choices Data on page 75.

6. Status bar. The status bar on the bottom of the Choices 3 Viewer window gives information on the survey being displayed and the base (i.e., filter) currently being used for the data in the table.

Using the Choices 3 Viewer window

When the Run Analysis button in Choices 3 is used there will be three items in the table of contents: Analysis View, Crosstab View, and Private Eye Ranking View.

Crosstab View

The Crosstab View is the analysis that is displayed when the Choices 3 Viewer is first opened. This is a table of columns and rows. All the items selected for the columns and rows (from the Coding window) will be displayed. The table will probably extend off the edges of the screen and the scroll bars at the bottom and right side may be used to see all the columns or rows. For help interpreting the data, go to Interpreting Choices Data on page 75.

The base (filter) used for the analysis is listed in the status line.
Changing the base

To change the base (if you selected more than one filter when setting up your analysis), select the **Change Base** button in the tool bar. This will open the **Select Base** window. Clicking on the down arrow will open a list of the filters you selected. Highlight the one you want to have displayed on the Crosstab and click the **OK** button. This will change the base used in the Crosstab and the table will display the new data.

Data in the rows and columns can be selected for manipulation by clicking on the segment of wide border above the columns or beside the rows.

**Arrange data in columns or rows**

Clicking on the border above the column will allow you to arrange the data in ascending or descending order according to the data element you select. To do this, click on the border segment for the column you want to work on. This highlights the entire column. Next, click on the **Sort Ascending**, **Sort Descending** or **No Sort** button. This opens the **Element** window.

You may select the element you want the program to use to sort the column by clicking on the radio button next to the element. Then click on the **OK** button and the column will be sorted according to your selection.

This procedure will also allow you to sort the data in the rows.

**Highlighting**

The **ChoicesViewer** gives you the option to highlight cells according to criteria you select.

To turn this feature on, click on the **Highlighting Criteria** button. This will open the **Cell Highlighting** window. Select the Element, By Value, and Color (as a minimum) and click on **OK**. The Crosstab table will then display any cells that meet your criteria in the color you selected. In the sample pictured, cells with index values of 100 or greater are highlighted.
Changing the axis

You also have the option to change the axis of the columns and rows. Click on the Change Axes button and the Select Axes window will open. The top data field allows you to select a new orientation for the columns and the bottom data field the rows. You may use this option to reverse the positions of the columns and rows. When you have made your selections, click on the OK button.

Adding/removing data elements

You may add or remove the data elements displayed in the table cells by using the six buttons on the right side of the tool bar. These buttons (Sample Size, Weighted, Vertical %, Horizontal %, Index, and Total Table %) allow you to remove or display data elements so that only those you want are displayed. Click on the button for the element(s) you want to remove or display and the elements will be removed or added, one at a time.

Graphing your results

Once you have the data you want you may have that data presented in a graphic format. This is done by clicking on the Create Graph (Excel) or Create Graph icon. Please go to page 14 for more information about the graphing option.

Exporting your results

You have the option to export your analysis to Excel or to a generic .CSV (Comma Separated Values) file. Clicking on the Export to Excel icon will automatically open your analysis in Excel.

The Export Geo-Demographic (.CSV) File icon will export the data in a .CSV file to your selected destination. Excel can open .CSV files.

QuadMap

You also have the option to generate a QuadMap of selected data. To generate a quadmap, highlight two columns of data and click on the Generate QuadMap icon. This will generate a Quadmap in the Choices 3 Viewer window. The QuadMap is added to the table of contents in the column on the left. You may return to the Crosstab display by clicking on the Crosstab View selection in the table of contents.
**Return to Choices 3**

You may return to Choices 3 without closing the *Choices 3 Viewer* by clicking on the **Return to Choices** icon. This minimizes the *Choices 3 Viewer* window without losing the data from your analysis.

**Other icons**

The other options you have available to you include controls that will allow you to save, copy and print. There are also three icons that will allow you to zoom in and out to enlarge the text on the screen.

Other icons allow you to reverse the background and foreground colors (**Invert**) (i.e., white text on black background), **Hide** (you may hide a column by highlighting it and clicking on the **Hide** button) and **Reset Attributes**.

**Analysis View**

Clicking on **Analysis View** will display a table of columns and rows. All the items selected for the columns and rows will be displayed. However, only one data element at a time will be included in the display.

The Analysis View pictured has the Index data element displayed for each cell. To change the data element click on the icon for the data element you want to study.

The other icons and controls are the same for Analysis View as for the Crosstab View.

[Image of Analysis View window]
Private Eye Ranking View

Clicking on **Private Eye Ranking View** will display a table of columns and rows. All the items selected for the rows will be displayed. However, only one “column” of information (data originally selected for the columns in your analysis) will be presented at a time. The name of the column of data being displayed is in the cell in the upper left corner of the table (i.e., 22-24: AGE). The information originally displayed in the cells (i.e., index, sample, etc.) in the Crosstab will be spread out over a number of columns with the data elements as the column heading.

You may page through the Crosstab columns of information by clicking on the direction arrows in the upper right corner of the *Choices 3 Viewer* window. By clicking on these buttons you may go forward or back through the columns (i.e., Total Sample, or age groups) to compare data.

**Private Eye Button**

You may display matching rows by clicking on the **Private Eye** button. This will open the *Private Eye Ranking Criteria* window.

1. To use this feature you must select which element the criteria applies to. You may select the element from the drop-down menu in the data fields under Elements.

   Next, select the criteria from the drop-down menu in the data fields under Criteria. These include >, <, >=, <+, and =. There are also selections for **In Range** (this selects rows that match in the range “value 1” to “value 2”) and Top (this selects the top “n” rows).
A value must be typed into the Value 1 data field. If you selected In Range for a criteria a second value must be entered in the Value 2 data field.

You must also tell the program how you want the criteria to be combined. Selecting All of these means that a row must meet every criteria while Any of these means a row must match at least one criteria.

When you are finished making your selections, click on the OK button. The table in the Choices 3 Viewer will change to display the data that meets your criteria.

2. You also have the option to use the Compare to Column section. You may choose to compare the current column to another column by entering an element, selecting the criteria and selecting a column from the column drop-down menu.

When you are finished making your selections, click on the OK button. The table in the Choices 3 Viewer will change to display the data that meets your criteria.
Trender View

Once you have run a Trend Analysis the results will be available in the Choices 3 Viewer. You may have to expand the table of contents in the Report Navigator on the left side of the screen.

Clicking on Trender View will display a table of columns and rows. All the items you selected for the rows will be displayed. However, only one “column” of information (data originally selected for the columns in your analysis) will be presented at a time. The name of the column of data being displayed is in the cell in the upper left corner of the table (i.e., Total Sample). The information from the surveys you selected for the trend analysis will be displayed in the columns (i.e., NCS Fall 2005, NCS Fall 2003, NCS Spring 99).

You may page through the columns of information by clicking on the direction arrows in the upper right corner of the Choices 3 Viewer window. By clicking on these buttons you may go forward or back through the columns (i.e., Total Sample, or age groups – as in the analysis pictured throughout this section on the Choices 3 Viewer) to compare data.
**Trender Settings Button**

The **Trender Settings** button, in the tool bar for the Trender View, is normally grayed out until it is activated by clicking on one of the cells in the table.

This button allows you to modify the values displayed in the cells. Clicking on the **Trender Settings** button will open the **Trender Options** window. This will allow you to select the type of comparison and the comparison values that will be displayed.

The default selection is “None.” To change this click on the radio button next to the type of comparison you want to use (i.e., Average Survey). You may change the Comparison Values by clicking on the check boxes next to the two options.

Once you have made your selections, click on the **OK** button and the data in the Trender View will be displayed according to your selections.

The section of table below pictures the results displayed with the default settings. The section of table to the right displays the same cells with the Comparison Type set for “Average Survey” (CAS).

![Trender Options window](image)

![Comparison Table](image)
**Choices 3 Viewer Menu Bar**

The Choices 3 Viewer menu bar has six drop-down menus. These menus are File, Edit, View, Display Options, Analysis, and Help.

**File Menu**

The File drop-down menu has selections for saving, printing, exporting and other functions. This menu is divided into five sections.

1. The top section has selections for Open, Add, Save, Save As, and Close.
   - Clicking on the Open selection opens the Open window. This window displays a list of any previously saved reports. This is the same window that is opened when the Open button in the tool bar is selected.
     
     Select a report by highlighting its file name and click on the Open button to open that report in the Choices 3 Viewer.
   - The Add selection allows you to add the current report to a previously saved report. Clicking on Add will open the Open window. Select the report to add the current report to and click on the Open button. This will add the current report to the report selected.
     
     You must then close the current report and open the combined report by selecting Open in the File menu, highlight the report you added on to and click on the Open button in the Open window.
     
     This will open the combined report. Each report will have its own selection in the table of contents in the Report Navigator on the left side of the Choices Viewer screen.
   - Clicking on the Save selection will open the Save As window if the report has not been previously saved. (See below for information about the Save As window.) If it has been previously saved, any changes will be added to the file without any prompting. This is the same action that will be taken if you select the Save button from the tool bar.
   - The Save As selection will open the Save As window. This window will prompt you to name the file (in .rpt format). You also have the choice of selecting where you want the file to be saved. If you wish to save it to a USB Flash Drive select the D: or E: drive, depending on the computer you are using. Click on the Save.
button when you have finished.

- The **Close** selection will clear the *Choices 3 Viewer* screen but will not close the screen.
- The Save As Default Chart Template selection is grayed out and cannot be used.

2. The second section of the **File** menu has selections for **Print**, **Print Preview**, **Print Setup**, **Header/Footer**, and **Page Setup**.

   Clicking on the **Print** selection opens the *Print* window. This window allows you to select the printer you want as well as other options. When you have finished making your selections, click on the **OK** button to print your report.

   This is the same window opened when you click on the **Print** button in the tool bar.

- The **Print Preview** selection changes the *Choices 3 Viewer* screen to show you how the finished report would appear. If the report does not appear the way you want it you may change its appearance by using the **Print Setup** selection in the **File** menu. This is the same screen displayed when you click on the **Print Preview** button in the tool bar.

   You may either print from the Print Preview page by clicking on the **Print** button or close the screen by clicking on the **Close** button.

- The **Print Setup** selection opens the Print Setup window. This window allows you to modify some features of the finished document. For example, you may select whether the document will be printed on the paper in Portrait (vertical) or Landscape (horizontal).

- The **Header/Footer** selection opens the Header/Footer window. This window allows you to modify the default headers and footers to represent your report exactly the way you want it.

   You may switch between the headers and footers by clicking on the **Header** or **Footer** tabs in the Header/Footer window.

   Click on the **OK** button when finished.
• The **Page Setup** selection opens the Page Setup window. This window allows you to change various aspects of the way the page is presented.

You may modify the margins as well as add or remove the various lines and headers. The **Preview** box shows the results of the selections you make.

Click on the **OK** button when you are finished making your selections.

3. The third section of the **File** menu consists of three selections: **Send To**, **Export**, and **Import Correspondence Analysis File**.

• The **Send To** function is not available.

• The **Export** selection has five selections that are displayed when it is selected. They are: **Spreadsheet (CSV) File**, **SPC File**, **DPT File**, **Excel**, and **Geo-Demographic (CSV) File**.

  The **Spreadsheet (CSV) File** selection opens the **Save As** window with the **Save As Type** data field already set up for .csv files. This type of file (comma separated values) is an Excel readable file.

  Type in a name for the file and select where you want it to be saved. Select the USB Flash Drive select the D: or E: drive, depending on the computer you are using. Click on the **Save** button when you are ready to save the file. You may then open this file by using the Microsoft Excel program.

  The **SPC File** selection also opens the **Save As** window but the **Save In** data field has the Specs folder already selected. Name the file and click on the **Save** button. Files saved in the Spec folder are only available on the same computer they were saved on.

  The **DPT File** selection will also open the **Save As** window to export the report in .dpt format. This format (data processing table) is read by ChartMagician for graphing. Unless you have access to the ChartMagician program you should not use this selection. You may also open a .dpt file using the Choices 3 Viewer.

  Clicking on the **Excel** selection will open your analysis in Excel. This is the same function as clicking on the **Excel** button on the tool bar.

  **The Geo-Demographic (.CSV) File** selection will export the data in a .CSV file to your selected destination. Excel can open .CSV files. This is the same function as clicking on the **Export Geo-Demographic (.CSV) File** button on the tool bar.
• The **Import Correspondence Analysis File** selection will allow you to open files in .MIT format.

4. The fourth section of the **File** menu is a list of recently opened reports. You may reopen one of these reports by clicking on the report name.

5. The fifth section of the **File** menu has only one selection: **Exit**. Clicking on **Exit** will close the *Choices 3 Viewer* and return you to the *Coding* window.

**Edit Menu**

The **Edit** menu has four selections: **Group Names**, **Copy**, **Rename**, and **Delete**. The selections are all grayed out until certain items in the *Choices 3 Viewer* screen are selected/highlighted.

The Group Names selection does not perform any function.

The **Copy** selection is activated by clicking on any column or row in a Crosstab. Data copied using this command can be pasted into an Excel spreadsheet.

The **Rename** and **Delete** selections are activated by selecting a Crosstab directory in the Report Navigator on the left side of the *ChoicesViewer* screen.

Clicking on **Rename** will allow you to change the name of the Crosstab directory from the existing title to another of your choice (i.e., Untitled to Test).

Clicking on the **Delete Crosstab** selection will delete the highlighted Crosstab directory (i.e., Untitled or Test). This action will take place immediately without the program prompting you if you are sure. There is no recovery from this action.

**View Menu**

The **View** menu has three selections. These selections, **Status Bar**, **Edges** and **Toggle Chart Labels** are used to toggle various aspects of the *Choices 3 Viewer* off and on.

The **Status Bar** selection will hide or show the status bar at the bottom of the *Choices 3 Viewer* screen. This will make the viewing area for the table slightly larger.

The **Edges** selection will hide or show the thick edges of the top and left sides of the table display. This will also make the viewing area for the table slightly larger.

The **Toggle Chart Labels** is grayed out until a chart has been created in the *Choices 3 Viewer*. This selection will turn the labels for the various chart elements on and off.
Display Options

The Display Options menu has two different menus, depending on what is being displayed in the viewing area. When a Crosstab, Analysis View or Private Eye Ranking is displayed the menu is divided into four sections.

1. The top section has selections for Sample Size, Weighted, Vertical%, Horizontal%, Total Table%, and Index. These selections are used to display or hide the various data elements in the table cells. The selections with a checkmark are displayed while those without a checkmark are hidden. You may change the status of a selection by clicking on it.

These functions are the same as those achieved when the buttons in the upper right corner of the table display area are clicked on.

2. The second section of the Display Options menu has three selections: Zoom In, Zoom Out, and No Zoom. The Zoom In and Zoom Out selections allow you to enlarge or reduce the size of the table so that more (or less) of it is viewable at one time.

The No Zoom selection returns the table to its default size.

These functions are the same as those performed when the various zoom buttons on the tool bar are selected.

3. The third section of the Display Options menu has two selections: Font and Color Scheme.

The Font selection opens the Font Options window. This window has selections that will allow you to change the font name or size. Click on the OK button when you have made your changes.

The Color Scheme selection opens the Color Scheme window that gives you options to change the various colors used in the table display. Click on OK when you are finished making your changes.

4. The fourth section of the Display Options menu has one selection: StatTips. This selection shows or hides the pop-up display of data information that appears when the mouse pointer hovers over a cell.

When a chart is displayed in the viewing area the Display Options menu has only one active selection: Flip. Clicking on Flip will reverse the elements in the chart. The items listed in the colors chart will be moved to the chart items. The items that are in the chart will be moved to the colors chart.
Analysis

The Analysis menu is divided into five sections. The various selections are active or grayed out depending on what is being displayed or highlighted in the display area.

1. The first section has three selections: Invert, Hide, and Reset Attributes.

   The Invert selection will reverse the background and foreground colors (i.e., white text on black background).

   Selecting Hide will hide a selected column or row.

   Reset will revert the display to its original values and display all columns and rows in the default colors.

   These are the same functions that the Invert, Hide and Reset buttons on the tool bar perform.

2. The second section has three selections: Sort Ascending, Sort Descending, and No Sort. These selections are grayed out until a column or row is highlighted by clicking on the edge cell.

   The Sort Ascending and Sort Descending selections open the Element window. This window allows you to select which data element (i.e., index) you want to use to sort the data in this column or row. Select the data element by clicking on the radio button next to the element. Click on the OK button when you are finished. Depending on whether you selected Sort Ascending or Sort Descending the data will be sorted in either ascending or descending value order.

   The No Sort selection will return the data to its original order.

   These are the same functions performed by clicking on the Sort Ascending, Sort Descending and No Sort buttons in the tool bar.

3. The third section of the Analysis menu has five selections. These are Highlighting Criteria, Decimal Places Criteria, Change Axes, Change Base, and Trender Settings.

   • Selecting Highlighting Criteria gives you the option to highlight cells according to criteria you select in the Cell Highlighting window.
Select the Element, By Value, and Color (as a minimum) and click on OK. The Crosstab table will then display any cells that meet your criteria in the color you selected. In the sample pictured, cells with index values of 100 or greater are highlighted.

This is the same function performed by the Highlighting Criteria button in the tool bar.

- The Decimal Places selection opens the Decimal Places Criteria window where you have the option to select the values where one or two decimal places will be displayed. The program will only display one or two decimal places but the criteria by which this happens may be adjusted.

When you have finished entering your criteria click on the OK button to return to the ChoicesViewer window.

- Clicking on the Change Axes selection opens the Select Axes window. This window gives you the option to change the axis of the columns and rows.

The top data field allows you to select a new orientation for the columns and the bottom data field the rows. You may use this option to reverse the positions of the columns and rows. When you have made your selections, click on the OK button.

This is the same function that is performed when the Change Axes button on the tool bar is selected.

- The Change Base selection in the Analysis menu opens the Select Base window. This window allows you to change the base displayed for the analysis (if you selected more than one filter when setting up your analysis).

To change the base, click on the down arrow in the Select Base window. This will open a list of the filters you selected. Highlight the one you want to have displayed on the Crosstab and click the OK button. This will change the base used in the Crosstab and the table will display the new data.

This is the same function that is performed when the Change Base button in the tool bar is selected.
The Trender Settings selection will open the Trender Options window. You may select the comparison type you want by clicking on the radio button next to your choice. You may also choose the Comparison Values by clicking on the check box next to one or both of the values available. Click on the OK button when you are finished making your choices.

These choices will not take effect in the Private Eye Ranking View but will be displayed any time a Trend Analysis is run after this.

This is the same function that is performed when the Trender Settings button in the tool bar (which appears when a Trend Analysis is displayed) is clicked on.

4. The fourth section of the Analysis menu has five selections. They are Private Eye, First Target, Previous Target, Next Target, and Last Target. These selections are grayed out until the Private Eye Ranking View is selected in the Report Navigator on the left side of the Choices 3 Viewer window.

- The Private Eye selection opens the Private Eye Ranking Criteria window. For more information about the use of this window please go to page 51 in the Private Eye Ranking View section. This is the same window that is opened when the Private Eye button in the tool bar (which appears when the Private Eye Ranking View is displayed) is clicked on.

- The other selections in this section of the Analysis menu (First Target, Previous Target, Next Target, and Last Target) control the forward or reverse movement through the various targets (columns) originally placed in the Columns/Targets box of the Table Statistics area of the Coding window. These are the same functions that are provided by using the arrow buttons in the upper right corner of the Choices 3 Viewer window.

5. The fifth section of the Analysis menu has two selections: Chart in Excel Chart and Save Definition.

The Excel Chart selection and the Create Graph (Excel) button on the Choices 3 Viewer tool bar both open the MS Excel Chart Parameters window. This window is used to select the properties of the material you want to include in your chart. Please go to page 14 for more information about graphing your results.

The Save Definition selection opens the Save Definitions window. Enter a name in the data field and click on the OK button. The saved definition will be available in the Editor window. See page 42 for more information about the Editor window.
The Choices 3 Media Report Viewer Window

When you run an Interactive Press Reach and Frequency analysis in Choices 3 the results are displayed in a *Choices 3 Media Report Viewer* window.

The *Choices 3 Media Report Viewer* window consists of six major areas.

1. **Title bar.** The title bar lists the name (if any) of the file being displayed.

2. **Menu bar.** The menu bar consists of six menus: *File, Edit, View, Worksheet, Tools,* and *Help.*

3. **Tool bar.** The tool bar consists of a number of buttons that allow you to perform various functions on the analysis being displayed.

4. **Report Navigator.** The table of contents is displayed in the Report Navigator on the left side of the *Choices 3 Media Report Viewer* window. The table of contents has four selections for each analysis. These are R&F, Rank, Duplication Analysis, and Vehicle Graphs. If more analyses are run without closing the *Choices 3 Media Report Viewer* window the new analyses will be added to the table of contents in the Report Navigator.

5. **Media display area.** The display area on the upper right side of the *Choices 3 Media Report Viewer* window is where the media you selected for inclusion in your analysis is presented in a table with columns and rows.
6. Results display area. The display area on the lower right side of the *Choices 3 Media Report Viewer* window is where the results of your analysis are presented. You may change the base (if more than one filter was selected) and target in this area. The display presents the data developed from the media, costs, factors and schedule selections you make in the media display area above the results display area as well as the base and target selections in this area.

**Using the *Choices 3 Media Report Viewer* Window—R&F**

When the *Choices 3 Media Report Viewer* window is first opened the R&F selection is displayed. The media you selected for your analysis is displayed in the media display area and some preliminary results may be displayed in the results display area.

Before complete results can be computed, additional data must be entered into the various columns and cells of the media display area.

**Media Display Area**

In order to display accurate data for your analysis you must ensure the various data columns in the media display area contain the information pertinent to your analysis. To enter this data follow the steps below:

1. **Media Vehicle column.** The Media Vehicle column displays the media selections you originally selected in the *Coding* window for the *Rows*/*Media* box. You now have the option to edit the information about each vehicle and delete or duplicate media rows from this display.

   To enter information or edit the information about each vehicle, you must first open the *Vehicle* window. Each media vehicle has its own *Vehicle* window. There are a number of ways to open the *Vehicle* window: (a) clicking on the media cell in the Media Vehicle column, (b) clicking on the *Vehicle Details* button, and (c) selecting *Show Media Vehicle Details* in the *Vehicle* sub-menu of the *Worksheet* menu.

   a. Clicking on the cell of a media vehicle in the media vehicle column will open the *Vehicle* window specifically for that vehicle (i.e., *Vehicle - AMERICAN RIFLEMAN* window).

   The Vehicle window has four tabs: *Information, Cost Type, Cost Schedule*, and *Graph*. The *Information* tab is the tab that is displayed when the window is first opened.

   - The *Information* tab has data fields for the Title of the media vehicle, the Factor, and selections for the frequency of publication. You may change the title of the media vehicle by typing in a new name.

   You may also change the factor of this vehicle. The initial factor is 100. Please see page 44 for more information about factors.
You must select the frequency of publication in order for the program to compute accurate reach and frequency. You must know how often the publication is released (i.e., monthly, weekly, etc.). Click on the radio button next to your choice. You also have the option to enter a custom frequency if the vehicle you are using does not fit into the offered frequencies.

- The **Cost Type** tab displays the cost of entering an advertisement into this publication. Enter the amount your research has determined is appropriate. See the note below.

- The **Cost Schedule** tab allows you to enter information about the number of insertions and the discount rate. That is, some magazines offer a discount of their one time insertion cost if the insertion is made a certain number of times. For example, a magazine might have an insertion rate of $34,000.00 for one insertion. However, if the same advertisement is inserted three times the rate drops to $33,500.00 per insertion. The rate again drops for six insertions and again for nine. See the note below.

**Note:** This information is available in the Standard Rate and Data Services publications in the Business Library reference section. Some of the publications available are:

- Business Publication Advertising Source: BUS. LIB. HF5905 .S723
- Consumer Magazine Advertising Source: BUS. LIB. HF5905 .S725

The Business Library also has the SRDS in electronic format. Please ask a Business Library staff member for assistance in accessing the SRDS program.

To enter data in the **Cost Schedule** tab, click on the **Insert** button. This will cause a row of blank cells to appear in the data field. Under **Ins** enter the number of insertions (i.e., 3, 6, 9, etc.) at which time the rate will change. Then enter the rate in the **Cost** column. The program will automatically enter dollar signs, commas and decimal points. Click on the **Insert** button to enter another row of data. Continue until you have entered all the data you wish.

- The **Graph** tab displays a graph of the number of insertions versus the percent of reach this vehicle will produce.
b. Clicking on the **Vehicle Details** button or the **Show Media Vehicle Details** selection in the **Vehicle** sub-menu of the **Worksheet** menu will open the **Select Media Vehicle** window. This window has a drop-down menu of all the vehicles in the Media Display area.

Select the vehicle you want from the list and click on the **OK** button. This will open the **Vehicle** window for that particular vehicle (i.e., **Vehicle - AMERICAN RIFLEMAN**). This is the same window that is opened when the vehicle cell is clicked on as described in subparagraph (a) above.

2. **Cost.** The Cost column is subdivided into two columns. The left column displays the initial insertion cost for each vehicle. This is the value you entered in the **Cost Type** tab of the **Vehicle** window for each vehicle. The second column is blank.

3. **Indicator.** The Indicator column displays information on each vehicle. The current initial display is of the average rating of each vehicle. You may change the display by clicking on the **Indicator** button at the top of the column.

   This will open the **Information Column Settings** window. You may choose the information to display from the following selections: **Average Rating**—the percent of reach, **Reach (000)**—the number of people to which the magazine will be exposed, **Annual Publication Frequency**—the number of issues published in a year, **CPT**—displays CPM (Cost Per Thousand), or **Index**—an indicator of interest level. Make a selection by clicking on the radio button next to the item you want to display.

   This window also allows you to duplicate each vehicle against a selected target vehicle. You select the target from a drop-down menu of the vehicles in this analysis.

   When you have made your selections click on the **OK** button. This will change the display in the Indicator column.

3. **Factor.** The Factor column is used to enter or modify the factors associated with the various media vehicles. The factor determines the “worth” of each vehicle in the computations. A factor of 100% is the default entry for most vehicles. Please go to page 44 for more information about factors.

4. **Schedule Columns.** The Schedule Columns are used to indicate the number of actual insertions are made for each media vehicle. Each of the numbered schedule columns can be used to set up a different schedule. For example, the schedule in column one has four insertions for each vehicle. Schedule two has five insertions each while schedules three and four have varied insertions for the different vehicles.

   This is important because the number of insertions affects the cost of the schedule. The more insertions, the higher the cost.
The effect may be observed as the insertions are entered because as each cell has data entered the data in the Results Display area changes. If more than one schedule is completed, there is a column of data in the Results Display area below each schedule column that reflects the data for that schedule.

<table>
<thead>
<tr>
<th>Media Vehicle</th>
<th>Cost</th>
<th>Indicator</th>
<th>Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMERICAN RIFLEMAN</td>
<td>$34,000</td>
<td>$169.52</td>
<td>100 NS</td>
</tr>
<tr>
<td>FIELD &amp; STREAM</td>
<td>$43,000</td>
<td>$172.37</td>
<td>100 NS</td>
</tr>
<tr>
<td>GUN'S &amp; AMMO</td>
<td>$56,000</td>
<td>$222.27</td>
<td>100 NS</td>
</tr>
<tr>
<td>PETERSEN'S HUNTING</td>
<td>$12,000</td>
<td>$145.27</td>
<td>100 NS</td>
</tr>
<tr>
<td>OUTDOOR LIFE</td>
<td>$23,000</td>
<td>$139.73</td>
<td>100 NS</td>
</tr>
</tbody>
</table>

This way a variety of schedules may be directly compared.

**Schedule Properties Window**

Clicking on the numbered button at the top of the schedule column will open the Schedule Properties window for that schedule. This window allows you to study the properties of your schedule in great detail. There are nine tabs across the top of the window. They are Media Mix, Graph, Schedule, Audiences, Freq Dist, Graph, N-Tiles, Freq Ranges and Duplication.

You may also open the Schedule Properties window by clicking on the Frequency Distribution button in the tool bar or the Show Frequency Distribution selection in the Schedule sub-menu of the Worksheet menu. The button or the menu selection will open the Select Schedule Number window. Select the schedule number (i.e., 1, 2, etc.) and click on the OK button. This will open the Schedule Properties window for the schedule you want to examine.

- The Media tab is the tab that is displayed when the window is first opened. It shows general total information about the schedule in nine categories: Total Insertions, Total Cost, Reach (000), GRPs, CPM, Gross Impressions, Duplication, Reach (%), and Average Frequency.
- There are two **Graph** tabs. The first **Graph** tab displays a graph for a number of different selections. The selections are: **Total Insertions**, **Total Cost**, **Reach (000)**, **GRPs**, **CPM**, **Gross Impressions**, **Duplication**, **Reach (%)**, and **Average Frequency**. These are the same as the column headings in the **Media** tab. As each item is selected the graph changes to display that information.

- The **Schedule** tab shows the number of the schedule in a data field that allows you to tailor the name to suit your topic. The large box in the window lists all the media vehicles you included in the analysis. The Insertions column lists the number of insertions you have designated for each vehicle.

- The **Audience** tab shows information about the schedule in two columns. The first column lists categories of information. The first item (Target) is the name of the data element you used in creating the reach and frequency analysis. The other items are the same items as the column headings in the **Media** tab.

  The second column lists the information related to the items in the first column. (i.e., name of the target, total insertions, etc.)

- The **Freq Dist** tab displays the frequency distribution for each exposure level.

  There are six columns. These show the following:

  - **Exp** – The number of exposures.
  - **Reach** – The number of people in the target seeing exactly n exposures (n being the number in the exposure column).
  - **% Reach** – The percentage of the target seeing exactly n exposures.
  - **Exp+** – The number of exposures or more (i.e., 3+ is 3 or more).
  - **Reach+** – The number of people in the target seeing n or more exposures.
  - **% Reach+** – The percentage of the target seeing n or more exposures.
The second **Graph** tab displays a graph showing the frequency compared to the reach percentage. There is a selection that allows you to change the graph to present the frequency compared to the reach+ percentage. Click on the radio button next to your choice and the graph will change to present the data. You also may select the **Maximum Frequency** from a drop-down menu.

The **N-Tiles** tab displays the average frequency for each N-Tile. The frequency distribution can be divided into a series of equally sized n-tiles. Select how many n-tiles you need from the list on the left. The results show the average frequency for equally sized groups.

The **Freq Range** tab allows you to divide the frequency distribution into a series of discrete groups. Click on the exposure table on the left for each cut-off point.

The **Duplication** tab is blank.

When you have finished your study of the schedule and making any changes click on the **OK** button to close the **Schedule Properties** window.
Optimizing the Schedule

You may optimize each schedule by clicking on the Optimize button at the top of each schedule column. This will open the Press Optimization window. This is the same window that is opened when the Optimize button on the tool bar or the Optimize selection in the Schedule sub-menu of the Worksheet menu is clicked on. This window has five tabs: Campaign Period, Parameters, Goal, GA Fitness Params, and Genetic Algorithm.

- The Campaign Period tab has selections for months or weeks in the Units box. Select one of these by clicking on the radio button next to the selection. In the Count data field enter the number of months (or weeks) you want this schedule to be used.

- The Parameters tab allows you to set the following guidelines:
  - Include – Clear the checkbox to exclude a vehicle from the analysis.
  - Min – Minimum number of insertions to be added (i.e., always have at least this many insertions for this vehicle. This number cannot be greater than the maximum).
  - Min if – If at least one insertion is to be set then insert the number shown here (i.e., either put zero or at least this many insertions).
  - Package – Always add this many insertions each time (i.e., always buy insertions in packages of this amount).
  - Max – A maximum number of insertions allowed for this vehicle.
  - Factor – Apply a factor to up/down weight media vehicles. See page 44 for more information about factors.

- The Goal tab gives you a choice of two types of goals to set for the schedule:
  - Budget for Reach – The system will attempt to achieve the given reach using the most efficient budget.
  - Reach for Budget – The system will attempt to maximize reach using the entire budget.
• The GA Fitness Params tab has an interactive chart that displays the effect of three factors: Goal, CPM and Frequency. The factors may be adjusted by moving the slider below each item on the left side of the display. Moving the slider to the right increases the importance of that factor. The results will be displayed on the chart.

• The Genetic Algorithm tab allows you to see how your schedule will perform with the settings you have entered. Click on the Run button to initiate the process. A graph will be displayed showing the relationship between Reach and Cost. Also data will be entered into the Reach, Cost and CPM data fields.

Click on the OK button when you have finished making your choices.

If you wish to clear a schedule of all data that has been entered, click on the Clear Current Schedule button on the tool bar or select Clear Current Schedule from the Schedule sub-menu of the Worksheet menu.

You may clear all data from the worksheet by clicking on the Clear Entire Worksheet button in the tool bar or selecting Clear Entire Worksheet from the Schedule sub-menu of the Worksheet menu.

Results Display Area

As information is entered into the Schedule columns of the Media Display area the program will start to compute data and enter it into the Results Display area, which is the bottom section of the Choices 3 Media Report Viewer window.

The Refresh Results Now button and the Auto Refresh button allow you to choose how often the results are refreshed. The Auto Refresh button is automatically selected when the window opens. If you do not want the results to refresh as you make changes click on the Auto Refresh button to de-select it. With the Auto Refresh button de-selected the results will only be refreshed when you click on the Refresh Results Now button.
The top row of information in the Results Display area gives you information about the base. If you ran your analysis with more than one base you may switch to another base by clicking on the down arrow in that row. This will display a list of the bases (filters) you used. Click on the one you want to switch to and the results will change to reflect the new criteria.

The second row in the Results Display area gives you information about the target. If you included more than one target in your analysis you may switch to another target by clicking on the down arrow and selecting a new target from the list that will be displayed.

The remaining rows of the Results Display area give you information about the schedules you have created. The rows include Reach, CPM, Total Cost and much more. Definitions of the various terms are included in the dictionary on page 85.

You may change the terms that are included in your display. Click on the **Results Display** button in the tool bar or select **Results Display** from the **Worksheet** menu. This will open the **Results Display** window. The terms in the **Displayed** box on the left side of the window are those currently used in the Results Display area. The terms in the **Not Displayed** box are those that are available to add to the terms already being used. You may move terms from one box to the other by highlighting the term and clicking on the arrow buttons below the boxes. When you are finished making your choices, click on the **OK** button.

The columns of data in the Results Display area correspond to the individual schedules in the Media Display area.

### Saving Reach and Frequency Files

Clicking on the **Save** selection in the **File** menu will open the **Save As** window if the report has not been previously saved. (See below for information about the **Save As** window.) If it has been previously saved, any changes will be added to the file without any prompting. This is the same action that will be taken if you select the **Save** button from the tool bar.

The **Save As** selection will open the **Save As** window. This window will prompt you to name the file (in .rfa format). You also have the choice of selecting where you want the file to be saved. If you wish to save it to a USB Flash Drive select the D: or E: drive depending on the computer you are using. Click on the **Save** button when you have finished.

### Exporting Reach and Frequency Files

Clicking on the **Export tab delimited file** selection opens the **Save As** window with the **Save As Type** data field already set up for .txt files. This type of file is an Excel readable file. Excel will interpret the file into a spreadsheet.

Type in a name for the file and select where you want it to be saved. For a USB Flash Drive select the D: or E: drive depending on the computer you are using.

Click on the **Save** button when you are ready to save the file. You may then open this file by using the Microsoft Excel program.
Using the *Choices 3 Media Report Viewer* window—Rank

Selecting **Rank** from the table of contents on the left side of the page will open the vehicle rank table.

This table lists all the vehicles you selected for your analysis and ranks them against each other according to a variety of factors, including cost, CPM, reach and others.

If the table opens without a complete set of cost figures you may have to open the *Vehicle* window for each publication (vehicle) by clicking on the publication name and enter the cost information. The *Vehicle* window for the Rank display is similar to the *Vehicle* window from the R&F display. See page 64 for more information about the *Vehicle* window.

The **Rank** button above each column of data toggles the rank column to the left of the rank button on and off.

The **Column Order** button will open the *Column Order* window. This window allows you to select which data elements to display.

The items in the Displayed box correspond to the column in the table. The columns are displayed in the order in which the items appear in the box. You may change the order by highlighting the item and clicking on the up or down arrow button to move it.

You may remove an items by highlighting it and then click on the right arrow button. This will move it to the Not Displayed box.

Items may be moved from the Not Displayed box to the Displayed box by highlighting it and clicking on the left arrow button.

The **Save** and **Export** functions are the same as for the R&F display. Please go to page 72 for more information about these functions.
Using the Choices 3 Media Report Viewer window—Duplication Analysis

Selecting Duplication Analysis from the table of contents on the left side of the page will open the duplication analysis table.

This table shows you the percentage of duplication of the reach of each vehicle (publication) compared to each of the other vehicles.

Using the Choices 3 Media Report Viewer window—Vehicle Graphs

Selecting Vehicle Graphs from the table of contents on the left side of the page will open the vehicle graph.

This graph shows the relation of the various vehicles according to selected criteria. The criteria for the vertical axis and horizontal axis may be changed. The Vertical Axis and Horizontal Axis data fields have drop-down menus where you may select the criteria for the axis.

If more than one filter or target was used in the analysis you may change the element by selecting it from the menus in the Filter and Target data fields.
Interpreting Choices Data

Above is a sample Choices 3 Crosstab report showing:

NCS Fall 2005 ADULT FULL YEAR (JAN 05—SEPT 05) = The selected survey is the NCS Fall 2005 Full Year.

POP = The selected weight is the population.

Filter: MALE: GENDER = The universe (Filter/Base) selected is the male population (i.e., Number of Males age 18+ in the continental U.S.).

Sample: 10729 = The number of adult males who participated in the survey.

'(000): 101879 = The number of adult males in the general population the survey can be projected to represent. Three zeros are added to the end of the number (i.e., 101,879,000) after the decimal point (if present).
Selected Elements:

Sample. The number of actual people in this study who meet the specifications of both the Row and the Column.

\'(000). This number represents the total number of adults who meet the specifications of both the Row and the Column. The three 0s (000) should be added to the end of the number shown. This is the people in the general population that the survey is projected to represent.

**Vertical** = **Vertical percentage** (or percent down). The number of people who have a given characteristic, expressed as a percentage, as defined by the Column heading. This is best described and understood by beginning the sentence with the column heading.

**Horizontal** = **Horizontal percentage** (or percentage across). The number of people who have a given characteristic, expressed as a percentage, as defined by the Row heading. This is best described and understood by beginning the sentence with the row heading.

**Index.** This number indicates the likelihood, compared to the total population, of meeting the specifications of both the Column and the Row. The base number for comparison is 100, which means the group is neither more nor less likely to meet the criteria defined by the Column and Row.

**Base** = **Base percentage.** The percentage of the base that the cell represents.

A single asterisk (*) means that the projections are the result of 30 or fewer interviews. These projections are not sufficiently reliable to be used safely alone and have been included for consistency only, to permit the combination of such breakdowns into larger groups without loss of information. If you receive data with one asterisk consider broadening your search.

Two asterisks (**) mean that the projections are the result of 60 or fewer interviews. The projections are relatively unstable and should be used with considerable caution.

   Note that the program does not always label all results that meet the above criteria with a single or double asterisk. Even if a result is not tagged, if the number of interviews is relatively low the data should be used with caution.
Count Commands

Count commands are used to create n-tiles (that is, they allow you to count the number of respondents who fall into at least several categories from a defined list). Examples would be:

- Respondents to the survey who agree with between 4 and 8 lifestyle statements out of a list of 12.
- Respondents to the survey who read at least 3 magazines from the designated list.

To set up a count command you must first select the items to be counted. This may be done from either the answer list or from a list of items in the Columns/Targets or Rows/Media boxes in the Table Statistics area.

In the example pictured twelve items were selected from the list of answers to the attitude/opinion question of whether the interviewee agrees with the statements. Right-clicking with the mouse with the pointer on the list of highlighted items will open the Context menu. Select Define Count Coding from the menu. This will open the Count Coding window.

The Count Coding window is used to set up the criteria to define your special count coding.

- The first option is to name your new definition by typing in a name in the Title data field.
- Next, click on the Show Preview check box in the lower left corner of the window so that a check mark appears in the box. This will cause a box to be displayed that will show the frequency distribution for your selected items. The columns in this box are:

  - **Count** – The number of items a respondent appears in.
  - **Frequency** – A weighted figure for how many respondents fall into count items. Three zeros (000) must be added to these numbers.
  - **Cume Freq Asc** – Cumulative frequency in ascending order (i.e., for a count of 4 would be equivalent to 4 or less). Three zeros (000) must be added to these numbers.
  - **Cume Freq Desc** – Cumulative frequency in descending order (i.e., for a count of 4 would be equivalent to 4 or more). Three zeros (000) must be added to these numbers.
• The two fields in the **Criteria** box allow you to set the lower and upper limits for your count. In this example the lower limit is 4 and the upper limit is 8.

• The choices in the **Add to** box allow you to select where you want your new count command to be placed (i.e., **Coding** box, **Columns**, **Rows**, **Filters**, or **Scratch** boxes in the **Table Statistics** area).

• When you have finished making your selections click on the **Add** button to place your count command in your desired box on the **Coding** window.

• If you are finished setting criteria (you may change the upper and lower limits for more definitions but you should change the title of each definition) click on the **Close** button to close the **Count Coding** window and return to the **Coding** window.

With the count command(s) in the columns or rows boxes, continue to set up a Crosstab, placing the group to be analyzed in the opposing axis (columns or rows) and define the universe of the analysis by placing terms in the **Filters** box (if desired). See page 5 for more information about setting up a Crosstab.

Click on the **Run Analysis** button in the tool bar. Choices 3 will run the analysis and show how many respondents in each category met your count command criteria.
Volumetrics

Volumetrics are used to measure consumption of a product or service. Choices 3 allows you to analyze such products in volume units rather than just usage. For example, a question on the frequency of the purchase of state lottery tickets (from the 2005 survey) is pictured.

These can be analyzed by usage (i.e., how many users) but midpoint values can also be attributed for each of the frequency answers and calculate both total volume and average volume.

Using the lottery as an example you can define a medium lottery player and then find both the total number of medium users and the volume of lottery tickets bought by these medium users.

Total Users

To find the total users select “State Lottery – # Times Bought Tickets” from the question list and then select the answers to be included for a medium user. (i.e., Once a Week and 2 or 3 Times a Month)

Next select the Insert Into Coding button and then select Add to coding using OR from the drop-down menu. The coding will be sent to the Coding box. Type in a name in the Description data field (i.e., Medium Lottery Users) and then send the coding to the columns or rows boxes in the Table Statistics area.

Volume

For the volume, again select “State Lottery – # Times Bought Tickets” from the question list and then select the answers to be included for a medium user.

Then right-click on the highlighted answers and select Define Mean/Volumetric from the Context menu. This will open the Volumetrics/Mean window.

In the Volumetrics/Mean window:

Type a name in the Title data field (i.e., Medium Lottery Users – Volume).

Click on the check box next to Preview in the lower left corner of the window so that a check mark appears in the check box. This will cause the results to be displayed in the data box.
Note: If Preview is selected, the figures shown will represent the total universe of the survey (i.e., all adults 18+). Filters are not taken into account in the Preview. If a filter has been selected (i.e., male or female) a Crosstab will need to be run to provide volume for each filter. This also applies when using Means.

The MidPoint column shows the mean score used for each level of consumption, which is used in the calculation of averages. You may change the midpoints by overwriting the existing figures.

Adding up the Total column with give you the figure in the Weighted data field at the bottom, which shows that the volume of lottery tickets bought monthly by medium users is 100,858,500. Combined with the Weighted column data (adding the two figures), it shows that 32,070,000 people bought 100,858,500 lottery tickets (as medium users) per month. (Again, you must add three zeros (000) to the numbers to get actual figures.

Select Volume in the Send Options box by clicking on the radio button next to Volume.

Select where to send the definition to by selecting Coding, Rows, Column, Filter, or Scratch from the drop-down menu in the Send to data field.

Click on the Add button to send the definition to your destination and click on the Close button to close the Volumetrics/Mean window. The new item should be included in the box where you chose to send it.
Mean

Mean is associated with volumetrics in that they both use frequency data. Using the mean you can work out average values in a Crosstab. There are three mean options available:

Mean – Average based on the total survey sample.
Mean Excluding Nulls – Average based on respondents who are included in at least one of the answers selected in the definition.
Mean Excluding Zeros – Average based on respondents with a mid-point value of greater than 0.0.

Mean—Excluding Zeros

Continuing the example of state lottery tickets from the volumetrics section, to work out a mean score select all items for State Lottery – # Times Bought Tickets. Then right-click with the mouse pointer in the Answer List box and select Define Mean/Volumetric from the Context menu.

This will open the Volumetrics/Mean window.

Type a name in the Title data field (i.e., Mean Score – Lottery).

In the Send Options box, select Average. This will activate the data fields associated with this option. Select Mean in the first data field and Exclude Zeros in the second data field. (The third data field is grayed out until Median is selected in the first data field.) This selection allows you to include all users of a product or service, it excludes non-users.

Click on the check box next to Preview in the lower left corner of the window so that a check mark appears in the check box. This will cause the results to be displayed in the data box.

Note: If Preview is selected, the figures shown will represent the total universe of the survey (i.e., all adults 18+). Filters are not taken into account in the Preview. If a filter has been selected (i.e., male or female) a Crosstab will need to be run to provide volume for each filter. This also applies when using Volumetrics.
The **MidPoint** column shows the mean score used for each level of consumption, which is used in the calculation of averages. You may change the midpoints by overwriting the existing figures.

The **Sample** data field at the bottom shows the number of respondents who answered these questions.

The 2.94 in the **Weighted** data field means that the average number of lottery tickets bought by *ALL LOTTERY TICKET BUYERS (EXCLUDING NON-USERS)* is 2.94 tickets per month. This excludes any non-users.

Select where to send the definition to by clicking on the destination in the **Send to** box.

Click on the **Add** button to send the definition to your destination and click on the **Close** button to close the **Volumetrics/Mean** window. The new item should be included in the box where you chose to send it.

**Mean—Excluding Nulls**

Again using lottery tickets, the Mean Score Excluding Nulls would work out the average number of tickets bought by all users of lottery tickets.

Using the same selections for the items in the **Answer List** box right-click with the mouse to open the **Context** menu and again select **Define Mean/Volumetric** to open the **Volumetrics/ Mean** window.

Type a name in the **Title** data field (i.e., Mean Score – Lottery).

In the Send Options box, select **Average**. This will activate the data fields associated with this option. Select **Mean** in the first data field and **Exclude Nulls** in the second data field. (The third data field is grayed out until **Median** is selected in the first data field.) This selection allows you to include all users of a product or service, it excludes non-users.

In this example, the options of Mean—Excluding Zeros and Excluding Nulls provide the same results.
**Median**

Again using lottery tickets, the Median would determine the middle number of lottery tickets purchased.

Using the same selections for the items in the *Answer List* box right-click with the mouse to open the *Context* menu and again select **Define Mean/Volumetric** to open the *Volumetrics/Mean* window.

Type a name in the **Title** data field (i.e., Lottery Users—Median).

In the Send Options box, select **Average**. This will activate the data fields associated with this option. Select **Median** in the first data field. **Exclude Zeros** is the only selection in the second data field. The third data field has two selections, **Continuous** and **Discrete**.

Click on the check box next to **Preview** in the lower left corner of the window so that a check mark appears in the check box. This will cause the results to be displayed in the data box.

Note: If Preview is selected, the figures shown will represent the total universe of the survey (i.e., all adults 18+). Filters are not taken into account in the Preview. If a filter has been selected (i.e., male or female) a Crosstab will need to be run to provide volume for each filter. This also applies when using Volumetrics.

The **MidPoint** column shows the mean score used for each level of consumption, which is used in the calculation of averages. You may change the midpoints by overwriting the existing figures.

The **Sample** data field at the bottom shows the number of respondents who answered these questions.

The 1.37 in the **Weighted** data field means that the middle number of lottery tickets bought by *ALL LOTTERY TICKET BUYERS* is 1.37 tickets per month.

In this example the Discrete selection would give you a number of 1.00 in the **Weighted** data field.

Select where to send the definition to by clicking on the destination in the **Send to** box.

Click on the **Add** button to send the definition to your destination and click on the **Close** button to close the *Volumetrics/Mean* window. The new item should be included in the box where you chose to send it.
### Understanding Volumetrics and Means

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>total</td>
<td>24,017</td>
<td>2,150</td>
<td>815</td>
<td>1,159</td>
<td>758</td>
<td>438</td>
<td>440</td>
</tr>
<tr>
<td>Sample</td>
<td>(000)</td>
<td>(000)</td>
<td>(000)</td>
<td>(000)</td>
<td>(000)</td>
<td>(000)</td>
<td>(000)</td>
</tr>
<tr>
<td>verify%</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
</tr>
<tr>
<td>horiz%</td>
<td>100%</td>
<td>4.71%</td>
<td>8.59%</td>
<td>8.74%</td>
<td>8.67%</td>
<td>11.2%</td>
<td>10.6%</td>
</tr>
<tr>
<td>Index</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>Base</td>
<td>100%</td>
<td>4.71%</td>
<td>8.59%</td>
<td>8.74%</td>
<td>8.67%</td>
<td>11.2%</td>
<td>10.6%</td>
</tr>
</tbody>
</table>

#### Medium Lottery Users

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample</td>
<td>4,025</td>
<td>3,064</td>
<td>2,064</td>
<td>1,215</td>
<td>652</td>
<td>216</td>
<td>438</td>
</tr>
<tr>
<td>verify%</td>
<td>15.2%</td>
<td>10.3%</td>
<td>11.1%</td>
<td>12.8%</td>
<td>10.6%</td>
<td>10.6%</td>
<td>10.6%</td>
</tr>
<tr>
<td>horiz%</td>
<td>100%</td>
<td>6.43%</td>
<td>6.43%</td>
<td>6.43%</td>
<td>6.43%</td>
<td>6.43%</td>
<td>6.43%</td>
</tr>
<tr>
<td>Index</td>
<td>100</td>
<td>70</td>
<td>70</td>
<td>70</td>
<td>70</td>
<td>70</td>
<td>70</td>
</tr>
<tr>
<td>Base</td>
<td>100%</td>
<td>6.60%</td>
<td>6.60%</td>
<td>6.60%</td>
<td>6.60%</td>
<td>6.60%</td>
<td>6.60%</td>
</tr>
</tbody>
</table>

1. The information in box number 1 indicates the number of people who are medium purchasers of lottery tickets. For example, there are 967,000 people in the 22 to 24 age group who purchased lottery tickets. The criteria used for this information is on page 79 for Total Users.

2. Box number 2 indicates the number of lottery tickets bought by people who are medium purchasers of lottery tickets. For example, 2,877,000 lottery tickets were purchased by people in the 22 to 24 age group. The criteria used for this information is on page 79 for Volume.

3. Box number 3 indicates the percentage of lottery tickets bought by the people in that column. For example, 28.9% of the lottery tickets purchased by medium users were bought by people in the 22 to 24 age group. The criteria used for this information is on page 79 for Volume.

4. Box number 4 indicates the average of lottery tickets bought by people who purchase lottery tickets. For example, all users of lottery tickets purchased an average of 2.94 lottery tickets per month. The criteria used for this information is on page 81 for Mean Score Excluding Zeros.

5. Box number 5 indicates the average of lottery tickets bought by people who purchase lottery tickets. For example, all users of lottery tickets between the ages of 22 and 24 purchased an average of 1.99 lottery tickets per month. The criteria used for this information is on page 81 for Mean Score Excluding Zeros.
Definitions

General

(000): The projected number of people in the population. Three 000s are added to the number (following the decimal point, if present).

Alpha Search: Available by clicking on the binocular button above the Question List box. You may perform a full search of the entire database for a specific word.

Average Frequency: (In a Reach and Frequency.) The average number of issues read by each person in the target market.

Base %: The percentage of the currently selected base that the specific cell represents.

Columns/Targets: Columns are also called targets. For the basic Crosstab, this information will appear vertically on the page.

Cost: Most commonly used for print titles as the rows. This cost can be any number but usually represents a single insertion in the publication.

CPM: Cost Per Thousand. This is only applicable when costs have been entered. This number represents the cost per thousand people reached by the given row, column and base.

CPM: (In a Reach and Frequency.) Whether this is the Cost Per Thousand Reach or the Cost Per Thousand Gross Impressions, it is the total cost of the schedule divided by either the Reach or the Gross Impressions expressed in Thousands.

Dictionary. A hierarchical list containing all the categories and questions asked in a particular study. Used to search for and select categories to specify as bases, columns and rows.

Duplication: (In a Reach and Frequency.) This compares the Reach of the schedule with the Gross Impressions. Therefore, if the Reach was 600 and the Gross Impressions were 900 then the duplication would be 33% (i.e., Gross Impressions minus Reach, divided by Gross Impressions).

Filter/Base: A Filter/Base is the universe of the report. If no base is selected Choices 3 defaults to the universe of the study. For the NCS the default universe is all adults 18+ in the 48 continuous states.

Gross Impressions: (In a Reach and Frequency.) This is the total opportunities to see the campaign or schedule. (Reach multiplied by the average frequency.)

GRPs: (In a Reach and Frequency.) Gross Rating Points. These are the Gross Impressions expressed as a percentage of the target market. Therefore, if the Gross Impressions are 600 and the population of the target is 1200, then the GRPs are 50.

Horizontal %: The row percentage. The percentage of the corresponding row total that the specific cell represents (based on weighted counts).
**Index:** An indication of how the weighted numbers in the cell differ from expected within the specified filter. An index of 100 corresponds to the average (or no difference); an index of greater than 100 indicates higher than average and an index of less than 100 indicates lower than average.

**Number of Vehicles:** (In a Reach and Frequency.) The number of titles referred to in a schedule.

**Projected Counts (000):** The representative number of people after sample-balancing has been applied to the raw sample counts. Often this number is also projected to the known universe such as the total population. Also referred to as weighted counts.

**Reach (000):** (In a Reach and Frequency.) The number of people exposed to at least one issue in a schedule. Three 000s are added to the number (following the decimal point, if present).

**Reach 2+ to Reach 13+:** (In a Reach and Frequency.) People exposed to at least 2, 3, 4 . . . 13 titles in the schedule. (i.e., 3+ is 3 or more.)

**Rows/Media:** Information selected as rows will appear horizontally in reports. Media (from the Media tab) MUST be selected as Rows when you are performing the Reach & Frequency function.

**Recycle:** Items deleted from the Filters, Columns, Rows, or Scratch areas are moved into the Recycle area. Items may be retrieved from the Recycle area if needed.

**Sample Size:** The number of respondents actually interviewed. Also referred to as unweighted counts, sample counts or respondents.

**Scheduled Insertions:** (In a Reach and Frequency.) The total number of insertions in the schedule.

**Scratch:** This is a holding area for data. It will NOT appear in any printed report. You may place items in Scratch to use them at a later time.

**Total Cost:** (In a Reach and Frequency.) The total cost of advertising of a particular schedule.

**Vertical %:** The column percentage. The percentage of the corresponding column total that the specific cell represents (based on weighted counts).
Logical Operators

Logical operators are used in Choices 3 to combine pieces of data to create a complex target. There are four types of logical operators used in Choices 3. Each of the areas where logical operators are used has buttons to insert these operators into the target. The logical operators are:

- **And**
  
  Condition One and Condition Two MUST be satisfied for inclusion. AND is used where the user wants to restrict a definition to a certain group (i.e., men aged 18-24 would be constructed as MALE AND AGED 18-24).

- **Or**
  
  At least one condition MUST be satisfied. If a respondent meets both conditions it is only counted once to avoid duplicating the audience. OR is used where the user wants to broaden a definition to include two or more answers (i.e., any user of Nestea, Tetly or Lipton would be constructed as NESTEA OR TETLY OR LIPTON).

- **Not**
  
  Condition One and NOT Condition Two MUST be satisfied. If a respondent satisfies both conditions it will not be included. NOT is used to exclude a certain group (i.e., females who do not watch Ally McBeal would be constructed as FEMALE NOT ALLEY MCBEAL).

- **Xor**
  
  Condition One or Condition Two but not Both must be satisfied. If a respondent satisfies both conditions it will not be included. XOR stands for “Exclusive OR” and is used when looking at members of one group or another but not both (i.e., eat Total or Wheaties, but not both would be constructed as TOTAL XOR WHEATIES).

Use of Parenthesis

Choices 3 reads complex coding from the left to the right. If you are creating a statement that contains more than one type of logical operator parenthesis must be utilized. Parenthesis will indicate to Choices 3 how to calculate any given coding statement. The system combines the answers within the parenthesis first (collapsing them into a new variable or answer) and then combines it with everything outside the parenthesis.

To create a definition of “Men with a household income of $30,000+ who read either Sports Illustrated or GQ”. You might use the following logic statement:

Q1 and Q2 and Q3 or Q4, where

- Q1 = Men
- Q2 = House hold income of $30,000+
- Q3 = Sports Illustrated
- Q4 = GQ

However, Choices 3 interprets this as “Men with a household income of $30,000+ who read Sports Illustrated or ANYONE (including women or men with house hold income of less than $30,000) who read GQ.

The correct statement to use would be: Q1 and Q2 and (Q3 or Q4)
Functions
The various functions that are available by selecting Function from the Menu Bar are described below. Detailed procedures for using these functions are described in the Basic Operating Steps section starting on page 5.

Crosstab
A Crosstab is useful in helping you identify who your target is, what they read or what products they use. A Crosstab is the intersection of data in a row and column.
A Crosstab is created by cross-tabulating a variety of data, such as media, demographics, or product usage. The information is structured into a Crosstab by choosing a universe (base) of data, such as “Total Adults.” The next step involves choosing the data that will make up columns and then those that will make up rows.

Private Eye
The Private Eye application allows investigation of a target or media against any set of product, media, and/or demographic data. Using criteria specified by you, the program searches through the selected data and identifies every case where the target meets the criteria.

Trend Analysis
A Trend Analysis allows you to analyze multiple years of data in a single report. The Trend Analysis application will automatically tag data that shows statistically significant changes. It gives you the option to view the data with three different trending options: change from base year, change from prior year, and change from average year. (Only available when a historical collection of studies is developed.)

Reach & Frequency
A Reach & Frequency analysis enables you to identify the number of people exposed to an actual number of issues of a specific magazine/newspaper or a group of magazines/newspapers within a target market. The R&F interactive analysis provides you with instant calculations/results as specific media schedules are built. The R&F application includes interactive frequency distribution and N-Tile analysis.